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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

You can visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
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1 Overview
HP Systems Insight Manager

HP Systems Insight Manager (HPSIM) is the foundation for the unified 
server-storage management strategy of HP. It is a multiple operating system, 
hardware level management product that supports HP ProLiant, Integrity, 
and HP 9000 servers; HP StorageWorks MSA, EVA and XP arrays; and other 
third-party arrays. HPSIM provides the basic management features of device 
discovery and identification, single event view, inventory data collection, and 
reporting. It easily integrates with other HP management products and 
plug-ins, such as the ProLiant Essentials, Integrity Essentials, and HP 
Storage Essentials-Storage Resource Management (SE SRM).

HPSIM can be extended to provide system management with plug-ins for HP 
clients, storage, power, and printer products. It uses plug-in applications for 
rapid deployment, performance management, partition management, and 
workload management. This enables you to choose the value-added software 
required to deliver complete life cycle management of your hardware assets.

Features

• Supports fault monitoring, inventory reporting, and configuration 
management for ProLiant, Integrity, and HP 9000 systems; HP 
StorageWorks MSA, EVA and XP arrays; and various third-party arrays 
through a web-based GUI or command line.

• Supports base-level management of HP clients and printers. Can be 
extended with HP Client Management software and HP Web JetAdmin 
for advanced management capabilities.

• Provides notification, and automates response to pre-failure or failure 
conditions through automated event handling.
 9



• Facilitates secure and scheduled execution of operating system 
commands, batch files, and custom or off-the-shelf applications across 
groups of Windows, HP-UX, Linux, and nonstop systems.

• Enables centralized updates of BIOS, drivers, and agents across multiple 
ProLiant servers using system software version control.

• Enables secure management through Secured Socket Layer (SSL), Secure 
Shell (SSH), and operating system authentication. SSL is a  system for 
encrypting data sent over the Internet, including e-commerce transactions 
and passwords. With SSL, client and server computers exchange public 
keys, enabling them to encode and decode their communication

Benefits

• Role-based security 

Enables effective delegation of management responsibilities by providing 
system administrators with granular control over users and management 
operations. 

• Tools definitions 

Defines tools using simple XML documents that enable you to integrate 
off-the-shelf or custom tools. These tools can be command-line tools, 
Web-based tools, or scripts. Access to these integrated tools is governed by 
role-based security.

• Data collection and inventory reports 

Performs comprehensive system data collection, and enables you to 
generate detailed inventory reports for managed systems. Reports can be 
generated in HTML, XML, or CSV format.

• Snapshot comparisons 

Enables you to compare configuration snapshots of up to four different 
servers or a single server at a time. This functionality enables the system 
administrator in identifying configuration issues that can cause to system 
instability. The snapshot comparisons can also be used to save a picture of 
standard configuration for comparisons with other systems. 

• HP Version Control 
10 Chapter 1



Downloads the latest BIOS, driver, and agent updates for HP ProLiant 
servers running on Windows and Linux. It also identifies system running 
obsolete software, and updates system software across groups of servers. 
For HP-UX systems, the software distributor is integrated with HPSIM. 

For more information about HPSIM, visit the following website:

http://www.hp.com/go/hpsim 

Insight Management Agents

HP Insight Management Agents are tools that enhance the management of 
HP Proliant and Integrity servers. Insight Management Agents are part of the 
Proliant Support Pack or Integrity Support pack available for download from 
the HP Software and Drivers downloads. You can find more information about 
Insight Management Agents at the following websites:

http://welcome.hp.com/country/us/en/prodserv/servers.html 

http://h18013.www1.hp.com/products/servers/management/agents/
index.html 

http://h18013.www1.hp.com/products/servers/management/
smartstart/index.html 
Overview 11
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HP Systems Insight Management (SIM) Integration

HPSIM Integration (HPSIMInt) provides a smart link between HP 
Operations Manager for Windows (HPOM for Windows) and HPSIM – a 
market leading management solution for network systems, databases, and 
applications in heterogeneous IT environments. This smart link also provides 
features for monitoring and managing the HPSIM and Insight Management 
Agents (IM Agents), host agent services, and enables event forwarding and 
event acknowledgement between HPSIM and HPOM for Windows. HPSIMInt 
consists of policies, tools, and messages to manage the functionality of HPSIM 
management servers and the IM Agents. HPSIMInt can be installed in 
environments consisting of multiple HPSIM management servers and IM 
Agent nodes.

Features and Functionality

HPSIMInt supports the following features on HPOM for Windows:

• Service discovery 

Supports discovery of HPSIM central management server (HPSIM CMS) 
and IM Agents.

• Service/process monitoring 

Monitors the availability of the discovered HPSIM and the IM Agent 
services. The service alerts can be communicated to the HPOM service 
navigator and the HPOM message browser.

• ProLiant server system monitoring 

Offers tool to configure IM Agent SNMP trap destination and policies for 
IM Agent SNMP traps. These policies generate HPOM event messages for 
server hardware problems.

• Event forwarding from HPSIM 

If you deploy the default HPSIM event forwarding and the IM Agent trap 
policies, duplicate events are forwarded from each of the SIM applications.
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Provides tools to configure forwarding of HPSIM events to HPOM 
message browser. Event forwarding can be configured to use a default 
event collection, or any customized collection of HPSIM events. The 
integration also associates an operator action with each HPSIM event, to 
launch the HPSIM web interface for further investigation.

• Bi-directional event acknowledgement/clearing on HPSIM 

Enables you to clear events on HPSIM if the events forwarded from 
HPSIM to HPOM are acknowledged on HPOM. When configured, events 
that are cleared on HPSIM are acknowledged on HPOM if they were 
forwarded from HPSIM and they exist in the HPOM active message 
browser.

• Tool groups 

Offers tools to assist in the management of HPSIM and IM Agent nodes. 
Tool groups include tools for adding nodes to HPSIM, executing tools on 
HPSIM managed nodes, launching the HPSIM web interface, and IM 
Agents System Management page, and so on.

• Policy groups 

Contain policies for monitoring the HPSIM and IM Agent services, 
clearing or acknowledging events, and IM Agents SNMP trap 
interpretation.

• Contextual launch to HPSIM system page 

Enables users to initiate contextual launch of the HPSIM CMS System 
page from HPOM messages.

• Web Interface tools 

Provides tools to launch the web interface for HPSIM, IM Agent, and 
Integrated Lights-Out (iLO).
Overview 13
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2 Installing HPSIM Integration
Prerequisites

To avoid problems during the installation of the HPSIMInt software, you 
should read this section and the documents named in this section before you 
start the installation process.

Hardware Requirements

The following documents explain all the hardware requirements:

• For the 8.10 management server:

HP Operations Manager for Windows Installation Guide

• For 8.10 HTTPS managed nodes:

HP OpenView Operations HTTPS Agent Concepts and Configuration 
Guide

• For HPOM 8.10 DCE managed nodes:

HP OpenView Operations OVO DCE Agent Concepts and 
Configuration Guide

Disk Space Requirements

Table 1 Disk space requirements
 15



    

System Operating System Installation
Runtime 
Files Total

HPOM 
management 
server 8.10

Windows 2008 (32-bit)
Windows 2008 EE (32-bit)
Windows 2003 R2 (32-bit)

4 MB 1 MB 5 MB

OVOW 7.5 Windows 2003 (32-bit) 4 MB 1 MB 5 MB

HPOM managed 
node

HP-UX 11.11
HP-UX 11.23 IA
HP-UX 11.23 PA
HP-UX 11.31 PA
HP-UX 11.31 IA

1 MB 1 MB 2 MB

Solaris 8, 9,10

RedHat Linux Advanced Server 
4.0 (32-bit and 64-bit)
RedHat Linux Advanced Server 
5.0 (32-bit)
SuSE Linux Enterprise Server 8 
(32-bit)
SuSE Linux Enterprise Server 9 
(32-bit and 64-bit)
SuSE Linux Enterprise Server 
10 (32-bit)

AIX 5.1, 5.2, and 5.3

Tru64 5.1B

Microsoft Windows 2003 (32-bit 
and 64-bit)
Microsoft Windows 2003 R2 
(32-bit and 64-bit)
Microsoft Windows 2008 (32-bit)

1 MB 1 MB 2 MB
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Software Requirements

• OVO for Windows 7.50 or HPOM for Windows 8.10, updated with the 
latest server and agent patches

• HP Operations Smart Plug-in Self-Healing Integration Component, 
Version 2.30

• OVOW_00244 patch for running HPSIMInt SPI 1.50 on OVOW 7.50

HPOM Management Server Versions

Table 2 Versions of HPOM management server  

HPSIM CMS Versions 

Table 3 Versions of HPSIM CMS

No additional memory (RAM) is required either on the HPOM management 
server or on the managed nodes for HPSIMInt.

HPOM Management 
Server Operating System

HPOM Agent 
Types

OVO 7.50 • Microsoft Windows 2003 
(32-bit)

DCE

HPOM 8.10 • Microsoft Windows 2003 
(32-bit)

• Microsoft Windows 2003 R2 
(32-bit)

• Microsoft Windows 2008 
EE (32-bit)

HTTPS

DCE
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HP Insight Management Agent Versions 

Table 4 Versions of HP Insight Management Agent
  

HPSIM CMS Operating System

HPSIM 5.1

HPSIM 5.2

HPSIM 5.2 SP1, 5.2 SP2

• Windows 2003 (32-bit & 64-bit)
• Windows 2003 R2 (32-bit & 

64-bit)
• Windows XP Professional, SP2 
• HP-UX 11.00 (supported only on 

OVOW 7.50)
• HP-UX 11.11
• HP-UX 11.23 PA/IA 
• HP-UX 11.31 PA/IA
• RedHat Linux AS 4 (32-bit and 

64-bit
• RedHat Linux AS 5 (32-bit and 

64-bit)
• SuSE Linux ES 9/10 (32-bit & 

64-bit)

HP Insight Management Agent Operating System

HP SmartStart CD v 7.8

HP SmartStart CD v 7.9

HP SmartStart CD v 8.0

• Windows 2003 (32-bit & 64-bit)
• Windows 2003 R2 (32-bit & 

64-bit)
• Windows 2008 EE (32-bit)
• Windows 2008 EE (only Smart 

Start 8.0)
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Installing HPSIMInt

Before you start installing HPSIMInt on the HPOM management server, 
ensure that the HPOM management server meets the installation 
Prerequisites discussed at the beginning of this chapter.
  

  

Follow these steps:

1 Log in to the HPOM management server as an administrator.

2 Insert the Smart Plug-ins, New and Upgraded, DVD into the DVD drive of 
the management server/console system. The installation wizard opens.

Deploy the agent with the latest patches to the node before deploying 
HPSIMInt.

Install HPSIMInt only from the DVD installer. Do not copy and run.msi files 
directly.
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3 In the Product Selection window, select HPSIM Integration and click Next.

The Installer executable verifies that HPOM is installed, installs the 
package, and loads the selected packages to the HPOM management 
server.

4 Follow the on-screen instructions to complete the installation process.

5 Click Finish to exit the installation wizard.

  

For detailed instructions on installing HP Operations Smart 
Plug-ins, see the New and Upgraded Smart Plug-ins DVD for HP 
Operations Installation/Upgrade Guide.
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Upgrading HPSIMInt

Follow these steps:

1 Verify the hardware and software requirements listed at the beginning of 
this chapter.

2 To preserve any policy customization made in the previous version, do a 
backup to save the complete and current HPSIMInt policies.

3 Stop the HPSIMInt Event Listener using the Stop Event Listener tool.

4 Remove the HPSIM CMS node from the node group using the De-assign 
HPSIM node from node group tool.

5 Uninstall older versions of the HPSIMInt policies from existing managed 
nodes.

a In the console tree, select Policy management > Policy groups > 
HPSIMInt. 

b Right-click and select All tasks > Uninstall from.

c Select the appropriate node group or nodes and click OK.

6 Install HPSIMInt from the DVD following the procedure in Installing 
HPSIMInt on page 19.

7 Ensure that the Auto-deployment registry variable Disable is set to False.

8 Assign all the HPSIM CMS nodes that were de-assigned in step 4 back to 
the HPSIM CMS node group using the Assign HPSIM node to node group 
tool.

9 Run the Get HPSIM Credentials tool and the Start Event Listener tool.
22 Chapter 2



Verifying Installation

To verify that HPSIMInt installed successfully on the HPOM management 
server, open the HPOM management server console and check that the 
following elements are present.

Table 5 List of elements
  

  

The following policy groups are assigned to node groups. 

Elements Options

Node Groups HP SIM CMS-Unix
HP SIM CMS-Win
IM Agents-Win

Tools Group HPSIMInt
• HP Systems Insight Manager-Unix
• HP Systems Insight Manager-Win
• HPSIMInt Utils
• Insight Management Agents

Message Group HPSIMInt-IMAgents
HPSIMInt-Systems_Insight_Manager

Policy Group HP SIM Int
• HP SIM CMS-Win
• HP SIM CMS-Unix
• HP SIM Event Acknowledging
• IM Agent-Win

User Roles HP SIM Integration Admin

If any of the elements are not present, reinstall HPSIMInt.
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Table 6 List of policy groups assigned to node groups  

Installed File Locations

The following files and directories are created during the installation of HP 
SIM Integration on the HPOM management server. 

Node Groups Policy Groups

HP SIM CMS-Unix \HP SIM Integration\HP SIM CMS-Unix\Event 
Forwarding
\HP SIM Integration\HP SIM CMS-Unix\Service 
Discovery 
\HP SIM Integration\HP SIM CMS-Unix\Service 
Monitoring

HP SIM CMS-Win \HP SIM Integration\HP SIM CMS-Win\Event 
Forwarding
\HP SIM Integration\HP SIM CMS-Win\Service 
Discovery 
\HP SIM Integration\HP SIM CMS-Win\Service 
Monitoring

IM Agents-Win \HP SIM Integration\IM Agents-Win\Hardware 
Traps
\HP SIM Integration\IM Agents-Win\Service 
Discovery
\HP SIM Integration\IM Agents-Win\HP Remote 
Insight Lights Out
\HP SIM Integration\IM Agents-Win\Service 
Monitoring
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Table 7 List of files and directories created during the installation    

The following directories for HP SIM Integration components are used to 
deploy policies to the DCE and HTTPS managed nodes.

Table 8 List of directories 

Component Location

Binaries and Scripts <OvInstallDir>install\HPSIMInt
<OvInstallDir>bin\HPSIMInt
<OvDataDir>shared\SPI-Share\HPSIMInt

Instrumentation <OvDataDir>Data\shared\Instrumentation\Win
dows 2008\6.0\HP SIM Integration
<OvDataDir>Data\shared\Instrumentation\Win
dows XP\5.1\HP SIM Integration
<OvDataDir>Data\shared\Instrumentation\Win
dows Server 2003\5.2\HP SIM Integration
<HPOMShareDataDir>Data\shared\Instrumenta
tion\HPUX\B.11.00\HP SIM Integration
<OvDataDir>Data\shared\Instrumentation\HPU
X\B.11.23\HP SIM Integration
<OvDataDir>Data\shared\Instrumentation\HPU
X\B.11.23 PI\HP SIM Integration
<OvDataDir>Data\shared\Instrumentation\HPU
X\B.11.31 PA\HP SIM Integration
<OvDataDir>Data\shared\Instrumentation\LIN
UX\Red Hat EL 3.0\HP SIM Integration
<OvDataDir>Data\shared\Instrumentation\LIN
UX\Red Hat EL 4.0\HP SIM Integration
<OvDataDir>Data\shared\Instrumentation\LIN
UX\SuSE Server 8\HP SIM Integration
<OvDataDir>Data\shared\Instrumentation\LIN
UX\SuSE Server 9\HP SIM Integration

Documentation <OvInstallDir>install\HPSIMInt\doc

Mof Files <OvInstallDir>install\HPSIMInt\NLS\1033\Mof
Files
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Operating System Installed Location

Microsoft Windows <OvAgentDir>\bin\instrumentation

HP-UX, Linux <OvInstallDir>/bin/instrumentation
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3 Configuring HPSIM Integration
Once HP SIM Integration is configured, the following functions are enabled:

• Service discovery

• Service monitoring

• Forwarding and interpreting IM agent SNMP traps

• Event forwarding from HP SIM to OM

• Event acknowledgement on OM when corresponding events are cleared on 
HP SIM

• Event clearing on HP SIM when corresponding events are acknowledged 
on the OM message browser

To configure HP SIM Integration, complete the following tasks in the order 
given.

Task 1: Identify the Nodes managed by OM

The first step is to identify the nodes that have to be managed by the OM. The 
OM must manage the nodes that are  required to be monitored either as agent 
Managed Nodes  or  agentless Nodes otherwise all the events generated from 
those nodes will be discarded by OM .

The next step is to install the HPOM agent on all the nodes where HP SIM or 
IM Agents are installed.

Before starting the HPOM agent installation, ensure that the system on 
which you want to install the HPOM agent meets the installation 
requirements (see Prerequisites on page 15). 
 27



You can install the HPOM agent on a managed node by various methods. For 
more information on the various installation methods, see the HP Operations 
Manager for Windows Installation Guide and also the documents listed 
Chapter 2, Installing HPSIM Integration.

Task 2: Install the HP Operations Agent on Nodes

Before starting the HP Operations agent installation, ensure that the system 
on which you want to install the HP Operations agent meets the installation 
requirements described in Prerequisites on page 15.

You can install the HP Operations agent on a managed node by various 
methods. These methods are described in the HP Operations for Unix 
Installation Guide and in the manuals listed on page 15.
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Task 3: Assign HP SIM CMS Nodes to a Node Group

The Assign HP SIM node to node group tool assigns the node to the chosen HP 
SIM CMS node group and deploys the HP SIM CMS policy groups, such as 
Service Discovery and Service Monitoring policies. The Service Discovery 
policy deployment runs the HP SIM service discovery process. If an HP SIM 
service is not discovered, the corresponding monitor policy is disabled.

To assign HP SIM CMS nodes to the correct node group, follow these steps:

1 Log on to the HPOM management server and start the HPOM Console.

2 Select Tools > HP SIM Integration > HP Systems Insight Manager-Win or HP 
Systems Insight Manager-Unix (depending on the operating system), and 
right-click Assign HP SIM node to node group.

3 Select All Tasks > Launch Tool. The Edit Parameters window opens.
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4 From the Select the nodes/services to replace $OPC paraeter with, 
select the node on which the HP SIM CMS is running.

5 Click Launch. The Tool Status window opens.
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This assigns the HP SIM CMS node to the HP SIM CMS-Win or HP SIM 
CMS-Unix node group and deploys service discovery and monitor policies. 

 

6 To view the status of the deployment job, select Policy Groups > 
Deployment jobs in the Policy management folder.

The process takes several minutes to complete.

After the processes are run, the HP SIM service map is created on the 
HPOM console. 

The HP SIM Integration category instrumentation gets deployed 
with the service discovery policy, to HP SIM CMS nodes.
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Assigning the Insight Management Agent Node to Node Group

The Assign IM Agent node to node group tool assigns selected nodes to the IM 
Agents-Win node group and deploys the IM Agents-Win policy groups Service 
Discovery policies. The IM Agent Service Discovery policy deployment runs 
the service discovery process. It discovers only those IM Agent services that 
are running, and deploys the respective service monitoring policies.

To assign the Insight Management Agent nodes to node group, follow these 
steps: 

1 Select Tools > HP SIM Integration > Insight Management Agents, and 
right-click Assign IM Agent node to node group.

2 Select All Tasks > Launch Tool. The Edit Parameter window opens.
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3 From the Select the nodes/services to replace $OPC parameters 
with, select the node on which IM Agents are running.

4 Click Launch. The Tool Status window opens.
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This assigns the IM Agent node to the IM Agents-Win node group.

5 To view the status of the deployment job, select Policy Groups > Deployment 
jobs in the Policy management folder.

The process takes several minutes to complete. 

After the processes are run, the IM Agent service map is created on the 
HPOM console.
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The HP SIM Integration category instrumentation gets auto-deployed with 
the service discovery policy to IM Agent nodes.
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Task 4: Obtain HP SIM Credentials

Many HP SIM Integration tools require HP SIM credentials for execution. To 
use these features, you must first enter the HP SIM credentials for each HP 
SIM management server. The credentials entered must be that of an HP SIM 
user who has full configuration rights and authorization for all tools, all 
managed nodes, and the CMS. This step is required only for the HP SIM CMS 
nodes. 
  

The following HP SIM Integration tools require HP SIM credentials:

• Fwd Cleared Imp Events

• Fwd Imp Events 

• Stop Fwding Imp Events 

• Stop Fwding Cleared Imp Events 

• Remove Query 

• Create Events Task 

• Remove Events Task 

• Execute HP SIM Tool 

• Get HP SIM Tool Status

• Add nodes to HP SIM 

• Get HP SIM nodes
  

To enter the HP SIM credentials, follow these steps:

1 Select Tools > HP SIM Integration > HPSIMInt Utils, and right-click Get HP SIM 
Credentials.

2 Select All Tasks > Launch Tool. The Edit Parameters window opens.

The Get HP SIM Credentials tool cannot be run from the HPOM Remote 
Console.

For more information on functions of HP SIM Integration components, see 
Using HPSIMInt Tools Group on page 73.
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3 From the Select the nodes/services to replace $OPC parameters 
with, select the node on which HP SIM CMS is running.

4 Click Launch.

The following message appears if the selected node is HP SIM CMS on 
Windows:

Enter the HP Systems Insight Manager DOMAIN\username:

The following message appears if the selected node is HP SIM CMS on 
UNIX:

Enter the HP Systems Insight Manager username:
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5 At the prompt, enter the HPSIM user name and press Enter. 
 

The following message appears at the prompt:

“Enter the HP Systems Insight Manager password:”

6 Enter the corresponding HPSIM password and press Enter. The following 
message appears at the prompt:

Done creating hpsimcms.conf file.
Press any key to continue . . .

The tool attempts to verify the user name and password. On success, you 
are prompted to press Enter to exit. If the credentials entered are not 
authenticated by HPSIM, the following message appears:

Failed to validate the HP SIM CMS credentials. Possible 
causes
could be:
1. HP SIM CMS is not installed
2. HP SIM CMS service is not running
3. HP SIM CMS credentials incorrect
Press any key to continue . . .

7 Press Enter. The command prompt window closes.
  

  

HPSIM user must have privileges to add, remove, and modify tasks 
and queries.

Event forwarding task creation does not function correctly if the HP 
SIM credentials are incorrect. If you do not know the user name 
and password, contact your system administrator.

After successful execution, the hpsimcms.conf file is created on the 
HP SIM CMS node.
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Task 5: Configure the HPOM Agent for a Non-Root 
User on UNIX Systems

  

Follow these steps. 

1 Log on to the managed node as a root user, and open a terminal window.

2 Open the following instrumentation directory for the HTTPS node:

cd /var/opt/OV/bin/instrumentation

3 Enter the following command at the command prompt to generate the 
HPSIMInt.su file:

./HPSIMInt_perl HPSIMInt_root.pl

The following message appears:

The script has completed successfully.

Providing Access to HPSIMInt Tools

Follow these steps:

1 Log on to the managed node as a root user, and open a terminal window.

2 Open the following file:

/etc/HPSIMInt.su

3 Edit the file by uncommenting or by adding the following lines:

root:/opt/mx/bin/mxstart 
root:/opt/mx/bin/mxstop

The following enables a non-root user to start or stop HPSIM services.

root:*

The following enables a non-root user to run the Get HPSIM Nodes tool, 
the Add Nodes to HPSIM tool, the Get HPSIM Tool Status tool, and the 
Get HPSIM Credentials tool.

For information on configuring the HPOM agent to run as an alternative 
user, see the HP OpenView Operations HTTPS Agent Concepts and 
Configuration Guide.
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HPSIMInt User Roles

The installation of HPSIMInt adds an HPSIMInt Admin user role.
  

The HPOM administrator can assign roles or responsibilities to HPOM users 
from the Actions > Configure > User Roles window. The users associated with 
the HPSIMInt Admin user roles have authorization for all the HPSIMInt 
tools, policies, and HPSIMInt-Systems_Insight_Manager and 
HPSIMInt-IMAgents message groups automatically assigned to the user. The 
user can also monitor and manage the HP SIM CMS and IM Agent nodes.

HPSIMInt Admin performs the following functions:

• Accesses all messages with Message Group attributes 
HPSIMInt-Systems_Insight_Manager and HPSIMInt-IMAgents from any 
node where HPSIM or IM Agent services are discovered.

• Runs any tool in the HPSIMInt tools groups.
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• Updates the HPOM service map, displaying the HPSIM and Insight 
Management Agents services successfully discovered.
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Task 6: Configure HPSIMInt to Forward HPSIM Events
  

Starting Event Listener on Each HP SIM CMS Node

Follow these steps:

1 Launch the Start Event Listener tool, which is available in the HP SIM 
Integration > HP System Insight Manager-Win or HP System Insight 
Manager-Unix tool group, depending on the operating system of HP SIM 
CMS node. The Select where to launch this tool window opens.

  

You can also configure a custom collection and task for event forwarding.
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2 From the Select Nodes/Services pane, select the HP SIM CMS node in the 
HP SIM CMS-Win or HP SIM CMS-Unix node group.

3 Click Launch. The Edit Parameters window opens.
  

4 Enter the port number in the Parameters field.

The parameter is -port 54321. In this instance, 54321 is the default port 
number of the Event Listener. Change this value if the TCP port 54321 is 
not available, or if you want to configure it on a different port. 

5 Click Launch. The Tool Status window opens.
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Configuring Event Forwarding from HPSIM to HPOM–Default

To forward events from HPSIM to HPOM, you must create an event collection 
and corresponding task on the HP SIM CMS. The default event forwarding 
task forwards events with Critical and Major severity levels. If the SP SIM 
and HP SE SRM setup is integrated, the default task will forward events of all 
severity to the OM.

To configure the default event forwarding, run the Fwd Imp Events tool from 
the HP System Insight Manager-Win or HP System Insight Manager-Unix tools 
group, depending on the operating system running on the HP SIM CMS node.
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The Fwd Imp Events tool create three collections named  
HPSIMInt_ImportantEvents, HPSIMInt_ApplicationEvents 
andHPSIMInt_SESRMInfraEvents and three tasks namely 
HPSIMInt_ImportantEvents,HPSIMInt_ApplicationEvents and 
HPSIMInt_SESRMInfraEvents.  

The collection HPSIMInt_ImportantEvents is created on the HP SIM CMS 
node for the events whose severity is either critical or major.

 The collection HPSIMInt_ApplicationEvents is created on the HP SIM CMS 
node for all the events belonging to the following event categories:

In an HP SIM and HP SE SRM integrated setup, the 
HPSIMInt_SESRMInfraEvents collection queries for all the event categories 
that contains "Storage Essentials" in its name.

• Systems Insight Manager Events

• Proliant Application Events

• Proliant System and Environmental Event

  

Configuring Event Forwarding from HPSIM to HPOM–Custom

You can create a custom event collection and task in addition to, or instead of, 
the default event forwarding collection and task.

Ensure that the Event Listener is running before you run the Fwd Imp 
Events tool. To check the status of the Event Listener, use the Status Event 
Listener tool.

On a HPSIM / HP SE SRM integrated setup,  the 
HPSIMInt_ApplicationEvents collection queries for the following event 
categories.  For the collection to include these event categories, ensure that 
the collections are created after the following relevant applications are 
installed.

• Storage Essentials Connector

• Storage Essentials Device Event

• Storage Essentials Agent

• Storage Essentials file system view
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To create an event collection through the HPSIM web interface, follow these 
steps:

1 Create an event collection on HPSIM to select the events to be forwarded 
to HPOM.

a Log on to the HPSIM management server console.

b Click Customize in the Systems and Events panel. The Customize 
Collections page opens.

Creating a user-defined collection and task for event forwarding can result in 
duplicate copies of HPSIM events being received on the HPOM management 
server.
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c Select Events from the Show collections of list. All available event 
collections are displayed.

d Click New. The New Collection section opens.

e Select Choose members by attributes. The New Collection section that 
selects the members by event attributes opens.  

f Enter the criteria of your requirement to forward events to HPOM.

g Click Save As to save the collection. The Save Collection As section 
opens.

h Enter a name for the collection in the Name field.
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i Select Private or Shared folder to select the location for saving the 
collection.

j Click OK to save the collection. 
 

2 Create a task on HPSIM to forward events to HPOM. Follow these steps:

a Launch the Create Events Task tool from the HP System Insight 
Manager-Win or HP System Insight Manager-Unix tool group, depending 
on the operating system running on the HP SIM CMS node. The 
Select Where to Launch this Tool page opens.

b Select the server to launch the tool.

c If a customized collection was created as mentioned in the steps to 
create Event collection through the HPSIM web interface , enter the   
-q option followed by the user-defined collection name. 

Example: -q myEventCollection

d To create a specific task name, enter the -t option followed by the 
required task name.

Example: -q myEventCollection -t myTask

e Click Launch.

An HPSIM event forwarding task is created on the HP SIM CMS node 
with the same name as the collection supplied in the -q parameter if the 
task name is not specified using the -t option.

For more information, see the HP SIM User Guide.
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Task 7: Configure Bi-Directional Event 
Acknowledgement/Clearing

Configuring Event Acknowledgement from HPSIM to HPOM–Default

HPSIMInt can be (optionally) configured to automatically acknowledge the 
forwarded HPSIM event on HPOM when the corresponding event is cleared 
through the HPSIM web interface.

This step creates an event collection and task to select the cleared events on 
HPSIM that correspond to the events displayed through 
HPSIMInt_ImportantEvents collection and forward the cleared events to the 
HPSIMInt Event Listener.

If the HPSIM event forwarding was configured using the Fwd Imp Events 
tool, complete the following steps to configure event acknowledgement:

1 Launch Fwd Cleared Imp Events from the HP System Insight Manager-Win 
or HP System Insight Manager-Unix tool group, depending on the operating 
system running on the HP SIM CMS node. The Select where to launch 
this tool window opens.

When duplicate message supression is enabled on the management server, 
the HP SIM integration requires the "Keep latest message text and 
severity" criteria to be selected for Bidirectional event acknowledgement for 
duplicate events to work correctly. Please refer to the HPOM guide for more 
details on Configuring HPOM server for message suppression.
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2 Select the HP SIM CMS node from the HP SIM CMS node group.

3 Click Launch. The Tool Status window opens.
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This tool adds the collection HPSIMInt_ClearedEvents, 
HPSIMInt_ClearedApplicationEvents and 
HPSIMInt_ClearedSESRMInfraEvents to the existing event collections on 
the HP SIM CMS. 

It also creates tasks HPSIMInt_ClearedEvents, 
HPSIMInt_ClearedApplicationEvents and 
HPSIMInt_ClearedSESRMInfraEvents on the HP SIM CMS. 

These tasks forward events cleared on HPSIM to the Event Listener for 
acknowledging these events on HPOM message browser.

The collection HPSIMInt_ClearedSESRMInfraEvents query the HP SIM 
CMS and HPSESRM integrated node for cleared events of all severities and 
those cleared events which belong to the category ‘Storage Essentials.
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The collection HPSIMInt_ClearedEvents query the HP SIM CMS node for all 
the cleared events whose severity is either critical or major. The collection 
HPSIMInt_ClearedApplicationEvents query the HP SIM CMS node for all the 
cleared events belonging to the following event categories: 

• Systems Insight Manager Events

• Proliant Application Events

• Proliant System and Environmental Events

• Storage Essentials Connector

• Storage Essentials Device Event

• Storage Essentials Agent

• Storage Essentials file system view

Both the queries will be active once the user executes the tool “forward 
important events”.

Configuring Event Acknowledgement from HPSIM to HPOM–Custom

If you configured a user-defined collection and task to forward HPSIM events 
to HPOM, you must create a second collection with the same selection criteria 
as the original user-defined collection to acknowledge these events.
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Under Search for events, select the criteria cleared state is Cleared, as shown in 
the following figure.   

      

To create an events task on HPSIM to forward cleared events to HPOM, follow 
these steps:

1 Launch Create Events Task from HP System Insight Manager-Win or HP 
System Insight Manager-Unix, depending on the operating system running 
on the HP SIM CMS node.

2 Select All Tasks > Launch Tool. The Select where to launch this tool window 
opens.

See the HP SIM User Guide for more information.
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3 Select the HP SIM CMS node from the HP SIM CMS node group.

4 Click Launch. The Tools Status window opens.

5 In the Additional Parameters field, replace the –q parameter with the 
user-defined cleared events custom collection name you created on the 
HPSIM web interface.

If the -t parameter is not supplied, an event forwarding task is created 
with the same name as the event collection supplied in the -q parameter. 
The task forwards events cleared on HPSIM to the Event Listener for 
acknowledging these events on the HPOM message browser.

To create a specific task name, enter the -t option followed by the desired 
task name; for example:

-q myClearedEventCollection -t myClearedEventTask
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The task name in the Create Events Task tool must start with an 
alphabet character. The other characters supported for the task name are 
space, hyphen, and underscore.

Configuring Event Clearing from HPOM to HPSIM

HPSIMInt can be configured to automatically clear an event on the HP SIM 
CMS if the corresponding event is acknowledged in the HPOM message 
browser. For this functionality, the policies in the policy group HP SIM 
Integration > HP SIM Event Acknowledging are deployed to the HPOM 
management server while installing HPSIMInt. The policies are:

• HPSIMInt-HPSIM_ClearEvents

• HPSIMInt-HPSIM_Auto_Acknowledge

• HPSIMInt-HPSIM_DupEvent_Acknowledge

To verify whether the polices are deployed on the HPOM console, follow these 
steps:

1 Right-click the HPOM node.

2 Select View > Policy Inventory and look for the presence of the above listed 
policies. 

If the policies are not deployed to HPOM, follow these steps:

3 Select Policy Groups > HP SIM Integration and right-click HP SIM Event 
Acknowledging.

4 Select All Tasks > Deploy on. The Deploy policies on window opens.
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5 Select the HPOM server node.

6 Clear deploy policy only if version is newer option.

7 Click OK.
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The forward cleared important events creates three collections named  
HPSIMInt_ClearedEvents, HPSIMInt_ClearedApplicationEvents and 
HPSIMInt_ClearedSESRMInfraEvents and tasks named 
HPSIMInt_ClearedEvents, HPSIMInt_ClearedApplicationEvents and 
HPSIMInt_ClearedSESRMInfraEvents. 

The collection HPSIMInt_ClearedApplicationEvents query the HP SIM CMS 
node for the events where the severity is either critical or major and all the 
events from certain applications forwarded to OM.

The collection HPSIMInt_ClearedSESRMInfraEvents query the HP SIM CMS

and HPSESRM integrated node for cleared events of all severities and those 
cleared events which belong to the category ‘Storage Essentials

In an HP SIM and HP SE SRM integrated setup, the 
HPSIMInt_SESRMInfraEvents collection queries for all the event categories 
that contains "Storage Essentials" in its name.

Both the queries will be active once the user executes the tool “forward 
important events”. Once these events are ‘cleared’ on HPSIM, the 
corresponding events on OM will be acknowledged automatically. 
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Task 8: Reconfigure HPSIMInt to Forward HPSIM Events

You can reconfigure HPSIM event forwarding to change the Event Listener 
port. If you configured event forwarding previously, check for the default 
HPSIMInt tasks and collections in HPSIM. If they exist, they must be deleted 
before proceeding with reconfiguration.

To delete tasks and collections existing in HPSIM, follow these steps:

1 Delete all the tasks for forwarding events including those for cleared 
events. For more information, see Deleting the HPSIMInt Event 
Forwarding Tasks and Collections on page 91.

2 Stop the HPSIMInt Event Listener, using the Stop Event Listener tool from 
the HP System Insight Manager-Win or HP System Insight Manager-Unix tool 
group, depending on the operating system running on the HP SIM CMS 
node.

 

3 To start the HPSIMInt Event Listener on a different port and add the 
event forwarding collection and task, see Task 6: Configure HPSIMInt to 
Forward HPSIM Events on page 42. 

 

–

Alternatively you can delete tasks and collections using HP SIM 
CLI. For more information on HP SIM CLI commands, see the HP 
SIM User Guide.

In many cases, if the HPSIM collection and task are correctly set 
up, after an HPOM agent or an HPSIMInt reinstallation, you only 
need to run the Start Event Listener tool for events to be forwarded 
to HPOM.  
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Task 9: Reconfigure HPSIM CMS Credentials for 
HPSIMInt

Follow these steps:

1 Stop the HPSIMInt Event Listener. 

2 Enter the new HP SIM CMS credentials. 

For more information, see Task 4: Obtain HP SIM Credentials on page 36.

3 Start HP SIM Integration Event Listener and add the event forwarding 
collection and task, see Task 6: Configure HPSIMInt to Forward HPSIM 
Events on page 42

  

The credentials are used by HPSIMInt when the Event Listener clears the 
event on HPSIM when acknowledged on HPOM.

The following tools require HPSIM credentials:

• Fwd Cleared Imp Events 

• Fwd Imp Events 

• Stop Fwding Imp Events 

• Stop Fwding Cleared Imp Events 

• Remove Query 

• Create Events Task 

• Remove Events Task 

• Execute HP SIM Tool 

• Get HP SIM Tool Status

• Add nodes to HP SIM 

• Get HP SIM Nodes

When it is necessary to reconfigure the HP SIM credentials on a node, all 
event forwarding tasks must be subsequently removed and recreated on the 
node for the HPSIM tasks to contain the correct credentials. For more 
information, see Task 8: Reconfigure HPSIMInt to Forward HPSIM Events on 
page 58.
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4 Using HPSIM Integration
HPSIMInt provides policies that enable you to configure event forwarding 
from HPSIM to HPOM. HPSIM events are received by the HPSIMInt Event 
Listener process on the HPSIM CMS node, and forwarded to HP OM through 
the HPOM agent. The events that are received by the HPSIMInt Event 
Listener are determined by the event collections and tasks that are 
configured, and are prioritized and assigned an HPOM severity level. 

By default, the messages generated by the HPSIMInt policies belong to the 
HPSIMInt-Systems_Insight_Manager or 
HPSESRMSPI-StorageEssentials_SRM message group. Additionally, the 
monitor policies monitor the status of the HPSIM service running on the 
HPSIM CMS server and the IM Agent services running on the managed nodes 
and generate messages to indicate any change in status. Message policies 
handle messages forwarded from HPSIM. Trap policies define the 
interpretation of SNMP traps from the IM Agent nodes.

The HPSIMInt Service Discovery policies discover the following services:

• HPSIM

• Insight Management Agents

The HPSIM Event Acknowledging policy group contains policies that, when 
deployed on the HPOM, handle event clearing or acknowledging between 
HPSIM and HPOM.
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Using HPSIMInt Policies

All policies provided with HPSIMInt are grouped under the HPSIMInt policy 
group. HPSIMInt provides a set of pre-configured policies for HPSIM and IM 
Agent nodes. These policies enable you to monitor the status of the services 
running on these nodes.

The HPSIMInt installation creates the following high-level policy groups:

• HP SIM CMS-Unix

• HP SIM CMS-Win

• HP SIM Event Acknowledging

• IM Agents-Win
  

For more information on the pre-configured policies provided by HPSIMInt, 
see Appendix A, HPSIM Integration Policy Groups.
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Using HPSIMInt Message Groups

HPOM uses message groups to combine management information about 
similar or related managed objects under a chosen name, and provide status 
information at a group level. Messages are categorized into groups to simplify 
message management.

All messages generated by HPSIMInt are grouped into any of the following 
message groups.

Table 9 List of message groups
  

Using HPSIMInt Messages

All events generated by HPSIMInt are grouped into the HPSIMInt-IMAgents 
message group or the HPSIMInt-Systems_Insight_Manager message group. 
The messages generated by HPSIMInt policies appear in the message browser 
window and contain information that is vital for troubleshooting any problems 
being reported.

The following mappings of HPSIM event severities to HPOM event severities 
are performed by HPSIMInt.

Table 10 List of mappings from HPSIM event severities to HPOM event severities

Message Group Description

HPSIMInt-IMAgents HP SIM Integration messages for 
IM Agents

HPSIMInt-Systems_Insight_Manager HP SIM Integration messages for 
HP SIM
Using HPSIM Integration 63



   

  

The following figure shows the message browser with the HPSIMInt messages 
received from the HP SIM CMS.

HPSIM Severity 
Level

HPOM Message 
Severity Level HPSIMInt Impact

Critical Critical A critical problem is detected 
that needs immediate attention.

Major Major A very significant event has 
occurred where immediate 
attention is advised. Some parts 
of the system or device may 
have ceased functioning 
properly.

Warning Warning A problem has been detected 
that must be corrected. This 
condition may escalate to a 
more severe condition.

Informational Warning A notable event has occurred, 
one without any obvious 
detrimental effects. This is 
purely an information event.

Normal Normal This event communicates 
information regarding normal 
operation.

Unknown Normal

Events with a severity of Normal are redirected to the HPOM acknowledged 
message browser in the HPSIMInt-HPSIM_Events policy. 
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The message content indicates the scope of the problem. The columns provide 
the following information:

• Severity – Specifies the severity of the message. The severities reported are 
normal, warning, minor, major and critical. By default, normal severity 
messages are redirected to the acknowledged message browser.

• Node – Name of the node that generates the message. If the message is 
forwarded from an HP SIM CMS, then it is the HP SIM server node name. 
If the message is generated by an IM Agent trap, then it is the IM Agent 
node name.

• Application – Systems Insight Manager

• Object – The system name of the event source.

• Text – A single line description of the event.

• Message Group – Values for messages generated by HPSIMInt; for 
example, HPSIMInt-IMAgents, HPSIMInt-Systems_Insight_Manager.

For events forwarded from HPSIM 5.2 SP2, the message text also specifies 
the trap details.
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Launching the HPSIM Web Portal from the Message Browser

Each message forwarded to the HPOM message browser from HPSIM 
contains an Operator Action to launch into the HPSIM web interface. It 
launches in the context of the device that the HPSIM event references. This 
allows the HPOM operator to determine the cause of the problem and perform 
corrective tasks for the events which belong to 
HPSIMInt-Systems_Insight_Manager message group.

To launch the HPSIM web interface, follow these steps:

1 Select an event, right-click the event, and select Commands > Start > 
Operator Initiated. The HPSIM logon page opens.

2 Sign in to HPSIM with proper credentials. 

3 If the version is HPSIM 5.1, then the HPSIM Selected Systems page lists 
the device reporting the event. On clicking on the system name, the 
HPSIM System page displays the device. Click on the Events Tab to view 
all the events. If the version is HPSIM 5.2, then the Operator-Initiated 
Action from a message, launches the event details page. 

The behaviours in both the versions are displayed with the help of screenshots 
given below:

$OPTION (variable) – The event listener uses the -option switch in the opcmsg 
call to pass additional HPSIM event fields to HPOM.    $OPTION(EventType) 
contains the HPSIM event type string. $OPTION(probableCause) contains 
the HPSIM event probable cause string. These fields are used in the 
HPSIMInt-HPSIM_Events policies.
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Using the HPSIMInt Service Map

HPSIMInt provides the administrator with the additional perspective of the 
following service maps.

HPSIM Service Map

HPSIMInt includes tools to discover the HPSIM service on a node and uses 
the discovered data to generate service maps that can be viewed by the 
administrator from the HPOM Console. Task 3: Assign HP SIM CMS Nodes to 
a Node Group on page 29 shows the HPSIM services view discovered by 
HPSIMInt tools and policies. When the listener starts, the service map 
displays the HPSIM CMS managed nodes.

The service maps display up to the SIM CMS managed nodes. This can be 
viewed once the getCredentials are given and the eventListener tool is 
running. 

The services discovered by HPSIMInt facilitate root-cause analysis of HPSIM 
service problems. The HPSIMInt monitor policy enables the HPSIM service 
maps to allow monitoring of the availability of the HP SIM management 
server service. The HPSIMInt service discovery policies discover the HPSIM 
service.

Insight Management Agents Service Map

HPSIMInt includes tools to discover the Insight Management Agent services 
on a node. It also includes policies for deployment on the HPOM management 
server that automatically discover the IM Agent services on nodes in the IM 
Agent Node Groups on a scheduled basis. Assigning the Insight Management 
Agent Node to Node Group on page 32 shows the Insight Management Agent 
service on the Service Map GUI view discovered by HPSIMInt. The HPSIMInt 
service discovery policies discover the following IM Agents services:

• Foundation agents

If the service map does not appear , ensure that the Event Listener is running 
and run the discover HP SIM CMS  tool. To check the status of the Event 
Listener, use the Status Event Listener tool.
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• NIC agents

• Server agents

• Storage agents

• System Management Home page Agent

• Version control agent

• Insight Lights-Out (iLO)
  

  

iLO is an optional feature. It is discovered only if it is present on the system. 
The server node must have an optional iLo board in order for this service to be 
present.

The services discovered by HPSIMInt facilitate root-cause analysis of 
problems in crucial elements of the HPSIM service and IM Agent services.

By default, propagation rules for the objects in service trees are defined as 
Unchanged. This means that a parent service does not change the status of a 
child object by attaching a priority to it. Such a scenario is feasible only if a 
parent service considered the status of one child service to be more important 
than the status of another child service.

Calculation rules for service trees are set, by default, to Critical. This means 
that if a parent service has more than one child service, it assumes the status 
equal to the highest severity of its child services.
70 Chapter 4



Viewing Services

The service maps are created a few minutes after Service Discovery is 
configured. To view the discovered services, click Services on the HPOM 
Management Console and select the appropriate service.
  

Viewing HPSIM CMS Services on the Service Map

When the service discovery policy is run, you can view the discovered services 
graphically represented within the HPOM service map.

To view the service map of HP SIM services, select Services > System 
Infrastructure on the left pane of the HPOM console. The HP SIM service map 
is displayed in the right pane.  

By default, the services are discovered by HPOM once every day at 02:00 am. 
You can change the service discovery period by modifying the service 
discovery policy. The changed discovery period comes into effect only after the 
policies are redeployed on the HPSIM node.
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Viewing IM Agent Services on the Service Map

When the service discovery policy is run, you can view the discovered services 
graphically represented within the HPOM service map.

To view the service map of IM Agent services, select Services > System 
Infrastructure on the left pane of the HPOM console. The Insight Manager 
service map is displayed on the right pane.
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Using HPSIMInt Tools Group

HPSIMInt adds the top-level tools group HPSIMInt on the HPOM 
management server. The HPSIMInt tools group consists of the following tool 
groups: 

• HP System Insight Manager-Unix

• HP System Insight Manager-Win

• HPSIMInt Utils

• Insight Management Agents

The HP System Insight Manager-Unix or HP System Insight Manager-Win 
tools group includes tools that are run on HP SIM CMS nodes (UNIX or 
Windows).
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Using the HP SIM-Unix Tools Group

This group contains tools for monitoring and configuring the HP SIM CMS on 
a UNIX node, as the following figure shows.   

The HP SIM-Unix tools group includes the following tools. 
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Table 11 List of tools in HP SIM-Unix tools group  

Tool Name Description Parameters

Add nodes to 
HPSIM

Adds nodes to the HPSIM 
server

The list of host names to be managed by 
HPSIM. The host names must be 
separated by a space, and the list must 
be within double quotes.
This parameter is mandatory. To pass a 
single name, double quotes are not 
required.

Assign HPSIM 
node to node 
group

Assigns HP SIM CMS node to 
\"HP SIM CMS-Unix\" node 
group.

De-assign 
HPSIM node 
from node group

De-assigns the HP SIM CMS 
node from the HP SIM 
CMS-Unix node group.
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Create Events 
Task

Creates Events Task on 
HPSIM to forward events to 
the  Event Listener

To forward events to the Event Listener:
—q <queryname> 

Replace <queryname> with the 
name of the HPSIM collection that 
the task must use to select the 
HPSIM events.

The collection name must be the 
name of an existing collection that 
was manually created, as described 
in the Configuring Event 
Forwarding from HPSIM to HPOM–
Custom on page 45. 

The collection name itself is used as 
the task name if only this parameter 
is specified. To specify other task 
names, use the optional parameter 
provided after this parameter.

-t <taskname> 

This is an optional parameter. 

Replace <taskname> with the task 
name you want to use.

Tool Name Description Parameters
76 Chapter 4



Execute HP SIM 
Tool 

Execute HP SIM tool on its 
managed nodes

First parameter 

The first parameter can be WAIT or 
NOWAIT. By default, the parameter 
is WAIT in the Execute HP SIM 
Tool tool.

WAIT 

With the WAIT parameter, the 
Execute HP SIM Tool tool returns 
the status of the HP SIM tool 
execution. The status is provided 
when the HP SIM tool execution 
reaches one of the following stages:

— Completed
— Cancelled
— Failed
— Killed

NOWAIT 

With the NOWAIT parameter, the 
Execute HP SIM Tool retrieves the 
JOB ID of the specified HP SIM tool.

This JOB ID can be supplied to the 
Get HP SIM Tool Status tool, to 
retrieve the status of the HP SIM 
tool execution.

Tool Name Description Parameters
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Second parameter 

Lists HP SIM managed host names 
where the tool is executed. The 
names must be separated by a blank 
space or a semicolon (;). The list of 
parameters must be enclosed within 
double quotation marks ("").

Third parameter 

The HP SIM tool to be executed.

Fourth parameter (optional) 

One or more parameters required by 
the tool must be specified. A blank 
space or a semicolon (;) must be 
used to separate them. The list of 
parameters must be enclosed within 
double quotation marks ("").

Fwd Cleared 
Imp Events

Creates the default collections 
and tasks on HP Systems 
Insight Manager for 
forwarding cleared important 
events from HPSIM to 
HPOM."

Fwd Imp Events Creates the default collections 
and tasks on HP Systems 
Insight Manager to forward 
important events from HP SIM 
to HPOM." 

 

Get HPSIM 
Nodes

Gets nodes being managed by 
the HPSIM server

Get HPSIM Port Gets the SSL port to be used 
by other HPSIM tools to 
communicate to the HPSIM 
server.

Tool Name Description Parameters
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Get HPSIM Tool 
Status

Gets the status of tool 
execution on HPSIM managed 
nodes.

The JOB ID of the task whose status is 
being queried. The JOB ID is returned 
by the Execute HPSIM Tool.

Launch HPSIM 
Console

Launches the HPSIM console. Select the HPSIM CMS node whose web 
interface you want to launch and run 
this tool. You can optionally specify 
additional parameters to open the 
System page or Tool page for the 
required HPSIM managed node(s).
The Launch HPSIM Console tool must 
be run on one node at a time.

Additional Parameters (optional)
First parameter (optional) 

System name of HPSIM managed 
node(s) whose system page you want 
to launch. You can only launch one 
system page.

Second Parameter (optional)

<tool name>

Tool name to launch the HPSIM 
Console to the tools page for the 
managed node(s) specified in the 
first parameter.

Examples:

— hpsimnode1.domain.com
— hpsimnode2.domain.com 

mytoolname

Tool Name Description Parameters
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Remove Events 
Task

Removes Events Task from 
HPSIM that forwards events 
to Event Listener.

-t <taskname>- 

Replace <taskname> with the name 
of the task to be deleted. The task 
name is the name of the existing 
event forwarding task on HPSIM 
that the user wants to delete.

Remove Query Removes the user-defined 
event collection from HPSIM.

Replace Additional Parameter 
<UserDefinedQuery> with the name 
of the event collection to be deleted that 
displays on the Systems and Events 
pane of HPSIM. Before running this 
tool, ensure that any HPSIM task that 
references this event collection is 
deleted (see Remove Events Task on 
page 80).

Start Event 
Listener

Starts HP SIM Integration 
Event Listener and registers 
as subagent of HPOM Agent to 
forward events to HPOM. The 
parameter is \"-p 54321\" 
where 54321 is the default port 
number of the Event Listener. 
Change this value if TCP port 
54321 is not available.

The parameter is -p <portNumber>, 
where 54321 is the default port number 
of the Event Listener. Change this value 
if TCP port 54321 is not available. 

Start HPSIM 
Service

Starts HPSIM Service. None

Status Event 
Listener

Gets the status of the 
HPSIMInt Event Listener that 
forwards events to HPOM.

None

Status HPSIM 
Service

Gets the status of the HPSIM 
Service.

None

Tool Name Description Parameters
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Stop Event 
Listener

Stops the HPSIMInt Event 
Listener and unregisters as 
subagent of HPOM Agent, to 
stop forwarding events to 
HPOM.

If the Event Listener is stopped, the 
HPSIM event forwarding task should be 
removed. 

Stop Fwding 
Cleared Imp 
Events

Stops forwarding the HPSIM 
cleared important events to 
HPOM, by removing the task 
\"HPSIMInt_ClearedEvents\" 
and the collection 
\"HPSIMInt_ClearedEvents\" 
on HPSIM.

None

Stop HPSIM 
Service

Stops HPSIM Service. None

Tool Name Description Parameters
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Using the HP System Insight Manager-Win Tools Group

This group contains tools for monitoring and configuring the HP SIM CMS on 
a Windows node. The following figure shows the HP System Insight 
Manager-Win tools group.   

The HP System Insight Manager-Win tools group includes the following tools. 
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Table 12 List of tools in HP System Insight Manager-Win tools group   

Tool Name Description

Add nodes to HPSIM Adds nodes to HPSIM server.

Assign HPSIM node to node 
group

Assigns the HP SIM CMS node to the HP SIM CMS-Win 
node group.

Create Events Task Creates Events Task on HPSIM to forward events to Event 
Listener.

De-assign HPSIM node from 
node group

De-assigns HP SIM CMS node from \"HP SIM CMS-Win\" 
node group.

Execute HPSIM Tool Execute HPSIM tool on its managed nodes.

Fwd Cleared Imp Events Creates the default collections and tasks on HP Systems 
Insight Manager for forwarding cleared important events 
from HPSIM to HPOM 

Fwd Imp Events Creates the default collections and tasks on HP Systems 
Insight Manager to forward important events from HP SIM 
to HPOM 

Get HPSIM Nodes Gets nodes being managed by the HPSIM server.

Get HPSIM Port Gets the SSL port to be used by other HPSIM tools to 
communicate to the HPSIM server.

Get HPSIM Tool Status Gets the status of tool execution on the HPSIM managed 
nodes.

Launch HPSIM Console Launch HPSIM Console.

Remove Events Task Removes Events Task from HPSIM that forwards events to 
Event Listener.

Remove Query Removes the user-defined event collection from HPSIM.

Start Event Listener Starts the HPSIMInt Event Listener and registers as a 
subagent of HPOM Agent to forward events to HPOM. The 
parameter is -p <portNumber>, where 54321 is the default 
port number of the Event Listener. Change this value if TCP 
port 54321 is not available.

Start HPSIM Service Starts HPSIM Service.
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Start OpenSSH Service Starts OpenSSH Service

Start Pegasus WMI Mapper 
Service

Starts Pegasus WMI mapper service.

Status Event Listener Gets the status of the HPSIMInt Event Listener that 
forwards events to HPOM.

Status HPSIM Service Status of HPSIM Service.

Status OpenSSH Service Status of OpenSSH Service.

Status Pegasus WMI Mapper 
Service

Status of Pegasus WMI Mapper Service.

Stop Event Listener Stops HPSIMInt Event Listener and unregisters as 
subagent of HPOM Agent to stop forwarding events to 
HPOM.

Stop Fwding Cleared Imp 
Events

Removes the HPSIMInt_ClearedEvents task and the 
HPSIMInt_ClearedEvents collection on HPSIM to stop 
forwarding the cleared important events from HPSIM to 
HPOM.

Stop Fwding Imp Events Removes the task \"HPSIMInt_ImportantEvents\" and the 
collection \"HPSIMInt_ImportantEvents\" on HPSIM, to 
stop forwarding the important events from HPSIM to 
HPOM.

Stop HPSIM Service Stops the HPSIM service.

Stop OpenSSH Service Stops the OpenSSH service.

Stop Pegasus WMI Mapper 
Service

Stops Pegasus WMI Mapper Service.

Tool Name Description
84 Chapter 4



Using the HPSIMInt Utils Tools Group

The HPSIMInt Utils tools group includes tools that enable you to perform 
administrative tasks for HPSIMInt. The following figure shows the tools in 
the HPSIMInt Utils tools group.   

The HPSIMInt Utils tools group includes the following tools.  
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Table 13 List of tools in HPSIMInt Utils tools group   

Using the Insight Management Agents Tools Group

The IM Agent tools group contains the tools that you can execute on IM Agent 
Windows nodes. Tools in this group enable you to perform the following tasks:

• Configure hardware trap destinations on the IM Agent nodes.

• Launch the IM Agent web interface.

• Start, stop, or get status of IM Agent services of the IM Agent services.

Tools Name Description

Clean HP SIM-Unix Deletes HP SIM Integration files on the HP SIM Unix 
managed node.

Clean HP SIM-Win Deletes HP SIM Integration files on the HP SIM Windows 
managed node.

Discover HP SIM CMS-Win Perform HP SIM CMS Service Discovery on Windows 
managed nodes.

Discover HP SIM CMS-Unix Perform HP SIM CMS Service Discovery on Unix managed 
nodes

Discover IM Agents-Win Performs Insight Management Agents Service Discovery on 
Windows managed nodes.

Get HPSIMM Credentials Get username and password of HPSIM for HPSIMInt.

Tracing On-Unix Sets the HPSIMInt tracing to ON state on the Unix 
managed nodes.

Tracing Off-Unix Sets the HPSIMInt tracing to OFF state on Unix managed 
nodes.

Tracing On-Win Sets the HPSIMInt tracing to ON state on Windows 
managed nodes

Tracing Off-Win Sets the HPSIMInt tracing to OFF state on Windows 
managed nodes.

Version Verify Verifies the version of HPSIMInt files.
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The following figure shows the tools in the Insight Management Agents tools 
group.    

The IM Agent Tools Group includes the following tools. 
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Table 14 List of agents in IM Agent tools group  

Tools Description

Assign IM Agent node to 
node group

Assigns Insight Management Agent node to \"IM 
Agents-Win\" node group.

De-assign IM agent node 
from node group

De-assigns Insight Management Agent node from \"IM 
Agents-Win\" node group.

Configure SNMP Trap 
Destination

Configures SNMP trap destination on the Insight 
Management agent nodes

Launch SysMgmt Homepage Launches System Management Home page.

Launch iLO Web Interface Launches Integrated Lights-Out Web Interface.

Start Foundation Agents Starts Foundation Agents Service.

Start NIC Agents Starts NIC Agents service.

Start Server Agents Starts Server Agents service.

Start Storage Agents Starts Storage Agents service.

Start Version Control Agent Starts Version Control Agent service.

Start SysMgmt Homepage Starts System Management Home page service.

Status Foundation Agents Status of Foundation Agents Service.

Status NIC Agents Status of NIC Agents Service

Status Server Agents Status of Server Agents Service.

Status Storage Agents Status of Storage Agents Service.

Status Version Control Agent Status Version Control Agent Service

Status SysMgmt Homepage Status of System Management Homepage Service.

Stop Foundation Agents Stops Foundation Agents service.

Stop NIC Agents Stops NIC Agents service.

Stop Server Agents Stops Server Agents service.
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Stop Storage Agents Stops Storage Agents service

Stop Version Control Agent Stops Version Control Agent service.

Stop SysMgmt Homepage Stops System Management Home page service

Tools Description

“Launch SysMgmt Homepage” tool must be run on one node at a time.
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5 Uninstalling HPSIM Integration
To uninstall the HPSIMInt software, complete the following tasks in the order 
given.

Task 1: Uninstall HPSIMInt Components from HP SIM 
CMS Nodes

Deleting the HPSIMInt Event Forwarding Tasks and Collections

To stop event forwarding from HPSIM to HPOM, you must delete the event 
forwarding collections and its corresponding tasks from the HPSIM 
management server. Follow these steps:

Run the Stop Fwding Imp Events tool on the HP SIM CMS nodes to delete 
HPSIMInt_ImportantEvents and HPSIMInt_ApplicationEvents the default 
collection and task for forwarding HP SIM events.

In an HP SIM and HP SE SRM integrated setup, the 
HPSIMInt_SESRMInfraEvents collection queries for all the event categories 
that contains "Storage Essentials" in its name.

If you configured default event acknowledgement from HPSIM to HPOM, run 
the Stop Fwding Cleared Imp Events tool to delete HPSIMInt_ClearedEvents 
and HPSIMInt_ClearedApplicationEvents. These are the default collections 
and tasks for acknowledging HPSIM events.
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To delete custom event collections and tasks from HPSIM, follow these steps:

1 Run the Remove Events Task tool for each custom task added to forward 
HPSIM events to HPOM, by providing the name of the custom task.

2 Run the Remove Query tool for each collection to remove it from HPSIM, 
by providing the name of the custom collection.

To verify whether HPSIMInt event task and collection are deleted, follow 
these steps:

1 Log in to the HPSIM web interface and ensure that there is no 
HPSIMInt_ImportantEvents, HPSIMInt_ApplicationEvents, 
HPSIMInt_SESRMInfraEvents, HPSIMInt_ClearedEvents, 
HPSIMInt_ClearedApplicationEvents, 
HPSIMInt_ClearedSESRMInfraEvents query in the Events > Shared tree 
on the Systems and Events panel.

2 Check for any custom event collections you added.

In an HP SIM and HP SE SRM integrated setup, the 
HPSIMInt_SESRMInfraEvents collection queries for all the event categories 
that contains "Storage Essentials" in its name. 
  

Deleting HPSIMInt Instrumentation from Nodes

1 Open the HPSIMInt Utils tool group in the HPSIMInt tools group.

2 Run Clean HP SIM-Win tool on the HP SIM CMS-Win nodes.

3 Run Clean HP SIM-Unix tool on the HP SIM CMS-Unix nodes.

Removing HP SIM CMS Nodes from HPSIMInt Node Groups

Launch De-assign HP SIM node from node group from the HP SIM Integration > HP 
SIM-Win tools group on the HP SIM CMS-Win node group.

You can also delete collections from the HP SIM web interface or by using HP 
SIM CLI. You can also delete tasks from   using HP SIM CLI. For more 
information on HP SIM CLI, see the HP Systems Insight Manager Command 
Line Interface Reference Guide.
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Repeat to remove nodes from the HP SIM CMS-Unix node group by using the 
appropriate tools in their respective tools group.
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Task 2: Uninstall HPSIMInt Components from IM Agent 
Nodes

Follow these steps:

1 Delete HPSIMInt instrumentation from IM agent nodes:

a Open the HPSIMInt Utils tool group in the HPSIMInt tool group.

b Run the Clean HP SIM-Win tool on the IM Agent-Win nodes.

2 Remove IM agent nodes from HPSIMInt node groups by launching 
De-assign IM Agent node from node group from the HP SIM Integration > 
Insight Management Agents tools group on the IM Agents-Win node group.
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Task 3: Uninstall HPSIMInt from the HPOM 
Management Server

  

1 Insert the Smart Plug-ins, New and Upgraded, DVD in the DVD-ROM 
drive.

2 Select Remove products to proceed to the product selection dialog.

3 Select HP SIM Integration from the Product Selection Uninstall window.
  

4 Click Next.

5 Select Remove.

6 Click Finish to complete the uninstallation procedure and exit the wizard.

This deletes all the configuration files and executables of HPSIMInt from the 
HPOM server. The HPSIMInt policies and tools are also deleted from the 
HPOM GUI.

If the Storage Essentials SRM SPI is installed, you must uninstall it. Select 
HPSIMInt in the Product Selection Uninstall window to uninstall the SPI.
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For more information on uninstalling HP Operations Smart Plug-ins, see the 
New and Upgraded Smart Plug-ins DVD for HP Operations Installation/
Upgrade Guide. 
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Task 4: Uninstall HPSIMInt from the HPOM User Roles 
GUI

The HPSIMInt node groups, tools group, tools, and policies are removed from 
the HPOM GUI during the uninstallation of the product. However, you must 
remove the HPSIMInt Admin user role manually.

The policies are removed from the deployed node and deleted from HPOM 
GUI only if the policies are not customized or updated.

Follow these steps:

1 Select Actions > Configure > User Roles. 

You can also click User Roles Configuration Editor located on the menu bar 
of the main HPOM management console. The User Roles window opens.

  

2 Select HP SIM Integration Admin and click Delete to remove the HPSIMInt 
Admin user roles from the HPOM User Roles. 
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6 Troubleshooting HP SIM Integration
Start by verifying that the procedures explained in Chapter 3, Configuring 
HPSIM Integration were completed successfully. In a successful installation, 
HP SIM Integration is configured as recommended and the messages that 
appear in the OM Events Browser are:

• Generated by HP SIM

• Intercepted by the HP SIM Integration templates

• Appear in theOM message browser in the form you are expecting

If the problem persists, refer to the following list of error messages.

Error Messages and Solutions

HP SIM events are not arriving on the HPOM message browser

Solution: 

1 Ensure that the connection between HPOM and the HP SIM CMS is up 
and running.

2 Send a test message from the HPOM console and ensure that it can be 
received in the HPOM Message Browser. You can send a test message 
using the command opcmsg on the managed node.

3 Ensure that the HP SIM services are running on the HP SIM CMS node.

4 Verify that the HPOM agent is correctly installed and configured on the 
HP SIM CMS server and that HPOM agent processes (and in particular 
the control agent and message agent) are running.

5 Ensure that you followed all the configuration steps in the order specified 
in Task 6: Configure HPSIMInt to Forward HPSIM Events on page 42.
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6 Ensure that the correct HP SIM Credentials are entered when configuring 
the HP SIM CMS node, as described in Task 4: Obtain HP SIM 
Credentials on page 36, before adding the node to the HP SIM node group.

7 The Get HP SIM Credentials tool can only be run on one node at a time.

8 Check the HP SIM Integration logs HPSIMInt_IndicationListener.log, 
HPSIMInt_Parser.log, and DetailsParser.log on the managed node for 
error messages. If the HP SIM credentials are invalid, there is a 
possibility of having error messages in the logs indicating authentication 
failures.

9 Ensure that the HP SIM Integration policies are correctly deployed to the 
HP SIM CMS or IM Agent nodes.

10 Ensure that HP SIM CMS or IM Agent nodes are added to the appropriate 
node groups. For more information, see Task 3: Assign HP SIM CMS 
Nodes to a Node Group on page 29 and Assigning the Insight 
Management Agent Node to Node Group on page 32.

11 Ensure that the HP SIM Integration Event Listener is running. For more 
information, see Starting Event Listener on Each HP SIM CMS Node on 
page 42 chapter.

12 Verify whether HP SIM Integration default events collections 
HPSIMInt_ImportantEvents and HPSIMInt_ApplicationEvents is present on the 
HP SIM CMS GUI in the Events > Public tree on the Systems and Events 
panel. Check the existence of the event forwarding tasks using HP SIM 
CLI command mxtask on the HP SIM CMS node.

13 Check the task definition and the Event Listener port to ensure that they 
are both configured for the same port number. If not, see Task 8: 
Reconfigure HPSIMInt to Forward HPSIM Events on page 58 to modify 
the port. 

To check the task definition, use the HP SIM CLI mxtask –if <taskname> 
command to list the XML task definition, and check the URL field to 
determine which port number the task is configured to send events to. 

Check the listener port by running the HP SIM Integration tool Status 
Event Listener. The tool output contains the Event Listener port.

14 Check the host that the HP SIM CMS and Event Listener are running on 
for port conflicts. Ensure that there are no other services running on the 
port that the Event Listener is using. If there is a port conflict, change the 
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port number and use a free port number. For more information on 
changing the Event Listener port, see Task 9: Reconfigure HPSIM CMS 
Credentials for HPSIMInt on page 59.

HP SIM services are not visible in the HPOM console

Solution: 

Ensure that the Service Discovery policies in the policy groups from Policy 
Management > Policy Groups > HP SIM Integration > HP SIM CMS-Win or HP SIM 
CMS-Unix > Service Discovery are deployed on the HP SIM CMS node. 

To check that the policies are correctly deployed, right-click on the node, select 
View > Policy Inventory, and verify that the Service Discovery policies are 
present. 

You can also check the service discovery log <OvAgentDir>\log\javaagent.log 
on the HP SIM CMS node for error messages.

IM Agent services are not visible in the HPOM console

Solution: 

Ensure that the Service Discovery policies present at Policy Management > 
Policy Groups > HP SIM Integration > IM Agents-Win > Service Discovery were 
deployed on the IM Agent node. 

To check that the policies are correctly deployed, right-click on the node, select 
View > Policy Inventory, and verify that the Service Discovery policies are 
present. 

You can also check the service discovery log <OvAgentDir>\log\javaagent.log 
on the IM Agent node for error messages.

Automatic acknowledgement from HPOM to HP SIM is not working

Solution: 

1 Ensure that you carried out the configuration steps described in Task 7: 
Configure Bi-Directional Event Acknowledgement/Clearing on page 49.
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2 Ensure that the correct HP SIM Credentials are entered when configuring 
the HP SIM CMS node. See Task 4: Obtain HP SIM Credentials on 
page 36 for more information.

3 Check the HP SIM Integration logs HPSIMInt_IndicationListener.log and 
HPSIMInt_Parser.log on the managed node for error messages. If the HP 
SIM credentials are invalid, there will be error messages in the logs 
indicating authentication failures. See Task 4: Obtain HP SIM 
Credentials on page 36 for instructions on entering the HP SIM 
credentials.

4 Ensure that the HP SIM Event Acknowledging policies 
HPSIMInt-HPSIM_ClearEvents and HPSIMInt-HPSIM_Auto_Acknowledge in 
Policy Management > Policy Groups > HP SIM Integration > HP SIM Event 
Acknowledging are deployed on the HPOM Management Server node. For 
more information, see Configuring Event Clearing from HPOM to HPSIM 
on page 55.

HP SIM event details in HPOM do not describe the problem 
adequately

Solution:

1 Select an HP SIM event from the message group 
HPSIMInt-Systems_Insight_Manager.

2 Right-click the event and select Commands > Start > Operator Initiated. The 
HP SIM logon page opens.

3 If the version is HP SIM 5.1, then the selected system page lists the device 
reporting the event. The HPSIM System page displays the devices when 
the System Name is clicked. Click on the Events Tab to view all the events 
from the device. If the version is HPSIM 5.2, then the Operator-Initiated 
Action from a message, launches the event details page.

Auto-deployment of policies failed on OVOW 7.50

Solution: 

Verify that the following registery key value is set to 0:

SOFTWARE\Hewlett-Packard\OVEnterprise\Management 
Server\AutoDeployment\Disable
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Version Verify tools fail on an agent running as non-root user

When the OM Agent is migrated from root user to non-root user, the Version 
Verify tools fail with the following error:

Cannot open collector output file /tmp/SIM_INT/SIM_INT.xml 
for writing

Solution: 

If the OM Agent is migrated from root user to non-root user, delete or rename 
the HP SIM Integration files/directories from /tmp on the nodes that were 
created by root user.
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A HPSIM Integration Policy Groups
The following figure shows the high-level HPSIMInt policy groups:
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HP SIM CMS-Unix Policy Groups

The following policies forward and acknowledge events on HPOM:

• Event Forwarding

Table 15 Event Forwarding policy
  

• Service Discovery

Table 16 Service Discovery policy
  

• Service Monitoring

Table 17 Service Monitoring policies
  

Policy Description Policy Type

HPSIMInt-HPSIM_Events_
Unix

Forwards and acknowledges the 
HPSIM events to HPOM

Open Message 
Interface

Policy Description Policy Type

HPSIMInt-HPSIM_AutoDisc
overy

Discovers HPSIM CMS services. Service 
Auto-Discovery

Policy Description Policy Type

HPSIMInt-HPSIM_HPSIMS
erviceMonitoring_Unix

Checks the HPSIM service on UNIX 
nodes.

Measurement 
Threshold

HPSIMInt-HPSIM_EventLis
tenerMonitoring_Unix

Monitors the HPSIMInt Event 
Listener on UNIX nodes.

Measurement 
Threshold
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HP SIM CMS-Win Policy Groups

The following policies forward and acknowledge events on HPOM.

• Event Forwarding

Table 18 Event Forwarding policy
  

• Service Discovery

Table 19 Service Discovery policy
  

• Service Monitoring

Table 20 Service Monitoring policies
   

Policy Description Policy Type

HPSIMInt-HPSIM_Events_
Win

Forwards and acknowledges the 
HPSIM Events to HPOM.

Open Message 
Interface

Policy Description Policy Type

HPSIMInt-HPSIM_AutoDisc
overy

Discovers HP SIM CMS Services. Service 
Auto-Discovery 

Policy Description Policy Type

HPSIMInt-HPSIM_OpenSS
HdServiceMonitoring-Win

Checks the OpenSSHd service on 
Windows nodes.

Measurement 
Threshold

HPSIMInt-HPSIM_WMIMa
pperServiceMonitoring-Win

Checks the Pegasus WMI Mapper 
service on Windows nodes.

Measurement 
Threshold

HPSIMInt-HPSIM_EventLis
tenerMonitoring-Win

Monitors the HPSIMInt Event 
Listener on the Windows nodes.

Measurement 
Threshold

HPSIMInt-HPSIM_HPSIMS
erviceMonitoring-Win

Checks the HPSIM service on 
Windows nodes.

Measurement 
Threshold
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HPSIM Event Acknowledging Policy Groups

The following policies clear events on HPSIM when these events are 
acknowledged on HPOM.

Table 21 List of policies which clear events on HPSIM
   

  

Policy Description Policy Type

HPSIMInt_ClearEvents Clears the events on HPSIM when 
the events are acknowledged on OVO 
Windows.

Scheduled Task

HPSIMInt-HPSIM_Auto_Ac
knowledge

Intercepts the acknowledged HPSIM 
events of message group 
HPSIMInt-Systems_Insight_Manage
r.

Windows 
Management 
Interface

HPSIMInt-HPSIM_DupEven
t_Acknowledge

Intercepts the changes in message 
text for HP Systems Insight Manager 
events

Windows 
Management 
Interface

These policies should be deployed to the HPOM management server.
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IM Agents-Win Policy Groups

• Hardware Traps

Table 22 List of policies in Hardware Traps
  

Policy Description Policy Type

HPSIMInt-IMAgents_FwdCI
MTraps

Forwards the IM Agents ProLiant 
GbE Switches SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdC
MCTraps

Forwards the IM Agents Console 
Management Controller SNMP 
Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdC
hannelArrayTraps

Forwards the IM Agents Fibre 
Channel Array SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdCl
usterTraps

Forwards the IM Agents Cluster 
SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdD
MITraps

Forwards the IM Agents DMI SNMP 
Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdDr
iveArrayTraps

Forwards the IM Agents Intelligent 
Drive Array SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdH
ostOSTraps

Forwards the IM Agents Host 
Operating System SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdIC
ATraps

Forwards the IM Agents Intelligent 
Cluster Administrator SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdID
EDriveTraps

Forwards the IM Agents Manageable 
IDE Drive SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdNI
CTraps

Forwards the IM Agents Network 
Interface Card SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdP
CConfigTraps

Forwards the IM Agents PC 
Equipment Configuration SNMP 
Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdPo
werDevicesTraps

Forwards the IM Agents Power 
Devices SNMP Traps.

SNMP Interceptor
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HPSIMInt-IMAgents_FwdR
PMTraps

Forwards the IM Agents Rack Power 
Manager SNMP Traps

SNMP Interceptor

HPSIMInt-IMAgents_FwdRa
ckTraps

Forwards the IM Agents Rack 
Information SNMP traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdRa
idControllerTraps

Forwards the IM Agents Raid 
Controller SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdRe
coverySvrTraps

Forwards the IM Agents Recovery 
Server SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdS
ANTraps

Forwards the IM Agents Storage 
Area Networks SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdS
CSIDevicesTraps

Forwards the IM Agents SCSI 
Devices SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdS
TEAMTraps

Forwards the IM Agents 
StorageWorks Enterprise Array 
Manager SNMP traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdS
WCCTraps

Forwards the IM Agents 
StorageWorks Command Console 
SNMP traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdSe
rverMgrTraps

Forwards the IM Agents Server 
Manager SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdSe
rviceIncidentTraps

Forwards the IM Agents Service 
Incident Information SNMP Traps. 

SNMP Interceptor

HPSIMInt-IMAgents_FwdSt
orageSysTraps

Forwards the IM Agents Storage 
Systems SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdSv
rHealthTraps

Forwards the IM Agents Server 
Health SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdSy
sInfoTraps

Forwards the IM Agents System 
Information SNMP Traps.

SNMP Interceptor

Policy Description Policy Type
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• HP Remote Insight Lights Out

Table 23 List of policy in HP Remote Insight Lights Out
  

• Service Discovery

Table 24 List of policy in Service Discovery
  

• Service Monitoring

Table 25 List of policies in Service Monitoring

HPSIMInt-IMAgents_FwdTh
resholdMgmtTraps

Forwards the IM Agents Threshold 
Management SNMP Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdU
PSTraps

Forwards the IM Agents 
Uninterrupted Power Supply SNMP 
Traps.

SNMP Interceptor

HPSIMInt-IMAgents_FwdO
neMsgPerTrap

Policy suppresses multiple messages 
for a single Trap Event ID.

Node Info

Policy Description Policy Type

Policy Description Type

HPSIMInt-IMAgents_FwdRI
BTraps

Forwards the IM Agents Remote 
Insight Board SNMP Traps

SNMP Interceptor

Policy Description Type

HPSIMInt-IMAgents_FwdRI
BTraps

Forwards the IM Agents Remote 
Insight Board SNMP Traps

Service 
Auto-Discovery
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Policy Group Policy Description Type

Foundation Agents HPSIMInt-IMAgents
_FoundationAgents

Checks the 
Foundation Agents 
Service.

Measurement 
Threshold

NIC Agents HPSIMInt-IMAgents
_NICAgents

Checks the NIC 
Agents Service.

Measurement 
Threshold

Server Agents HPSIMInt-IMAgents
_ServerAgents

Checks the Server 
Agents Service.

Measurement 
Threshold

Storage Agents HPSIMInt-IMAgents
_StorageAgents

Checks the Storage 
Agents Service.

Measurement 
Threshold

System Homepage HPSIMInt-IMAgents
_SysMgmtHomepage

Checks the System 
Management 
Homepage Service.

Measurement 
Threshold

Version Control 
Agent

HPSIMInt-IMAgents
_VCAgent

Checks the Version 
Control Agent 
Service.

Measurement 
Threshold
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B SNMP Trap Interceptor Policies
The IM Agents Hardware Traps policy group contains SNMP Trap Interceptor 
policies with rules or conditions to match SNMP traps from the IM Agents. 
The rules to match a trap generated for different status of the monitored 
object are the following.

HPSIMInt_IMAgents_FwdPowerDevicesTraps 
(cpqpower.mib)

1 Insight Management Agent: A critical alarm has 
occurred.(.1.3.6.1.4.1.232.165.1.1)

2 Insight Management Agent: A Warning Alarm has occurred. 
(.1.3.6.1.4.1.232.165.1.2)

3 Insight Management Agent: An Informational alarm has occurred. 
(.1.3.6.1.4.1.232.165.1.3)

4 Insight Management Agent: An alarm has cleared. 
(.1.3.6.1.4.1.232.165.1.4)

5 Insight Management Agent: This Trap is sent each time a power device is 
initialized. (.1.3.6.1.4.1.232.165.1.6)
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HPSIMInt_IMAgents_FwdServiceIncidentTraps 
(cpqservice.mib)

1 Insight Management Agent: A service incident is generated when it is 
determined that a service event has occurred upon an analysis of system 
initiated event traps or an update to a service event has 
occurred.(.1.3.6.1.4.1.232.0.164001)

2 Insight Management Agent: A service incident is generated when it is 
determined that a service event has occurred upon an analysis of system 
initiated event traps or an update to a service event has 
occurred.(.1.3.6.1.4.1.232.0.164002)

3 Insight Management Agent: A service incident is generated when it is 
determined that a service event has occurred upon an analysis of system 
initiated event traps or an update to a service event has 
occurred.(.1.3.6.1.4.1.232.0.164003)
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HPSIMInt-IMAgents_FwdChannelArrayTraps (uses 
CPQFCA.MIB)

The templates or templates and the rules or conditions in them are listed. The 
Insight Management Agent SNMP Trap from which traps are used to create 
the rules are mentioned in the parentheses following the template name.

1 Insight Management Agent: Fibre Channel Array Logical Drive status is 
FAILED contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16001)

2 Insight Management Agent: Fibre Channel Array Logical Drive status is 
RECOVERING, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16001)

3 Insight Management Agent: Fibre Channel Array Logical Drive status is 
READY for REBUILD, contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.16001)

4 Insight Management Agent: Fibre Channel Array Logical Drive status is 
REBUILDING, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16001)

5 Insight Management Agent: Fibre Channel Array Logical Drive status is 
WRONG DRIVE, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16001)

6 Insight Management Agent: Fibre Channel Array Logical Drive status is 
BAD CONNECTION, contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.16001)

7 Insight Management Agent: Fibre Channel Array Logical Drive status is 
OVERHEATING, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16001)

8 Insight Management Agent: Fibre Channel Array Logical Drive status is 
SHUTDOWN, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16001)

9 Insight Management Agent: Fibre Channel Array Logical Drive status is 
UNAVAILABLE, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16001)

10  Insight Management Agent: Fibre Channel Array Spare Drive status is 
FAILED, contained in SNMP Varbind 7 on bus contained in SNMP 
Varbind 5. (1.3.6.1.4.1.232.0.16002)

11  Insight Management Agent: Fibre Channel Array Spare Drive status is 
BUILDING, contained in SNMP Varbind 7 on bus contained in SNMP 
Varbind 5. (1.3.6.1.4.1.232.0.16002)

12  Insight Management Agent: Fibre Channel Array Physical Drive status is 
FAILED, contained in SNMP Varbind 7. (1.3.6.1.4.1.232.0.16003)
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13  Insight Management Agent: Fibre Channel Array Physical Drive status is 
PREDICTIVEFAILURE, contained in SNMP Varbind 7. 
(1.3.6.1.4.1.232.0.16003)

14  Insight Management Agent: Fibre Channel Array Physical Drive status is 
THRESHOLDEXCEEDED, contained in SNMP Varbind 7. 
(1.3.6.1.4.1.232.0.16003)

15  Insight Management Agent: Fibre Channel Array Accelerator Board 
status is TEMPORARILY DISABLED, contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.16004)

16 Insight Management Agent: Fibre Channel Array Accelerator Board 
status is PERMANENTLY DISABLED, contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.16004)

17 Insight Management Agent: Fibre Channel Array Accelerator lost battery 
power. Data loss is possible. (1.3.6.1.4.1.232.0.16005)

18 Insight Management Agent: Fibre Channel Array Accelerator Board 
battery status is failed. (1.3.6.1.4.1.232.0.16006)

19 Insight Management Agent: Fibre Channel Array Controller status is 
FAILED, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16007)

20 Insight Management Agent: Fibre Channel Array Controller status is 
OFFLINE, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16007)

21 Insight Management Agent: Fibre Channel Tape Controller Status is 
OFFLINE, contained in SNMP Varbind 4 for a tape controller contained 
in SNMP Varbind 3. (1.3.6.1.4.1.232.0.16008)

22 Insight Management Agent: Fiber Channel Tape Library Status is 
DEGRADED, contained in SNMP Varbind 7 for the tape library. 
(1.3.6.1.4.1.232.0.16009)

23 Insight Management Agent: Fiber Channel Tape Library Status is 
FAILED, contained in SNMP Varbind 7 for the tape library. 
(1.3.6.1.4.1.232.0.16009)

24 Insight Management Agent: Fibre Channel Tape Library Door Status is 
OPEN, contained in SNMP Varbind 7 for tape library. 
(1.3.6.1.4.1.232.0.16010)

25 Insight Management Agent: Fibre Channel Tape Library Door Status is 
CLOSED, contained in SNMP Varbind 7 for tape library. 
(1.3.6.1.4.1.232.0.16010)
116 Appendix B



26 Insight Management Agent: Fibre Channel Tape Drive Status is 
DEGRADED, contained in SNMP Varbind 7 for a tape drive. 
(1.3.6.1.4.1.232.0.16011)

27 Insight Management Agent: Fibre Channel Tape Drive Status is FAILED, 
contained in SNMP Varbind 7 for a tape drive. (1.3.6.1.4.1.232.0.16011)

28 Insight Management Agent: Fibre Channel Tape Drive Status is 
OFFLINE, contained in SNMP Varbind 7 for a tape drive. 
(1.3.6.1.4.1.232.0.16011)

29 Insight Management Agent: Fibre Channel Tape Drive Status is 
MISSING WAS OK, contained in SNMP Varbind 7 for a tape drive. 
(1.3.6.1.4.1.232.0.16011)

30 Insight Management Agent: Fibre Channel Tape Drive Status is 
MISSING WAS OFFLINE, contained in SNMP Varbind 7 for a tape drive. 
(1.3.6.1.4.1.232.0.16011)

31  Insight Management Agent: Fibre Channel Tape Drive cleaning required. 
(1.3.6.1.4.1.232.0.16012)

32 Insight Management Agent: Cleaning tape needs replacing 
(1.3.6.1.4.1.232.0.16013)

33 Insight Management Agent: Fibre Channel Host Controller Status is 
FAILED, contained in SNMP Varbind 4 for a host controller contained in 
SNMP Varbind 3. (1.3.6.1.4.1.232.0.16015)

34 Insight Management Agent: Fibre Channel Host Controller Status is 
LOOPDEGRADED, contained in SNMP Varbind 4 for a host controller 
contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.16015

35 Insight Management Agent: Fibre Channel Host Controller Status is 
LOOPFAILED contained in SNMP Varbind 4 for a host controller 
contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.16015)

36 Insight Management Agent: External Array Redundant Controller Active 
(.1.3.6.1.4.1.232.0.16014)

37 Insight Management Agent: Fibre Channel Array Physical Drive status is 
FAILED, contained in SNMP Varbind 7. (1.3.6.1.4.1.232.0.16016)

38 Insight Management Agent: Fibre Channel Array Physical Drive status is 
PREDICTIVEFAILURE, contained in SNMP Varbind 7. 
(1.3.6.1.4.1.232.0.16016)
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39 Insight Management Agent: Fibre Channel Array Physical Drive status is 
THRESHOLDEXCEEDED, contained in SNMP Varbind 7. 
(1.3.6.1.4.1.232.0.16016)

40 Insight Management Agent: Fibre Channel Array Accelerator Board 
status is TEMPORARILY DISABLED, contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.16017)

41 Insight Management Agent: Fibre Channel Array Accelerator Board 
status is PERMANENTLY DISABLED, contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.16017)

42 Insight Management Agent: Fibre Channel Array Accelerator lost battery 
power. Data Loss possible. (1.3.6.1.4.1.232.0.16018)

43  Insight Management Agent: Fibre Channel Array Accelerator Board 
Battery status is failed. (1.3.6.1.4.1.232.0.16019)

44 Insight Management Agent: Fibre Channel Array Controller status is 
FAILED, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16020)

45 Insight Management Agent: Fibre Channel Array Controller status is 
OFFLINE, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16020)

46 Insight Management Agent: Fibre Channel Host Controller Status is 
FAILED, contained in SNMP Varbind 4 for a host controller contained in 
SNMP Varbind 3. (1.3.6.1.4.1.232.0.16021)

47 Insight Management Agent: Fibre Channel Controller status is OK, 
contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16010)

48 Insight Management Agent: Fibre Channel Host Controller Status is 
LOOPFAILED, contained in SNMP Varbind 4 for a host controller 
contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.16021)

49 Insight Management Agent: Fibre Channel Host Controller Status is 
SHUTDOWN, contained in SNMP Varbind 4 for the host controller 
contained in SNMP Varbind 3.(1.3.6.1.4.1.232.0.16021).

50 Insight Management Agent: Fibre Channel Array Logical Drive status is 
FAILED, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16022)

51 Insight Management Agent: Fibre Channel Array Logical Drive status is 
RECOVERING, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16022)

52 Insight Management Agent: Fibre Channel Array Logical Drive status is 
READY for REBUILD, contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.16022)
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53 Insight Management Agent: Fibre Channel Array Logical Drive status is 
REBUILDING, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16022)

54 Insight Management Agent: Fibre Channel Array Logical Drive status is 
WRONG DRIVE, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16022)

55 Insight Management Agent: Fibre Channel Array Logical Drive status is 
BAD CONNECTION, contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.16022)

56 Insight Management Agent: Fibre Channel Array Logical Drive status is 
OVERHEATING, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16022)

57 Insight Management Agent: Fibre Channel Array Logical Drive status is 
SHUTDOWN, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16022)

58 Insight Management Agent: Fibre Channel Array Logical Drive status is 
UNAVAILABLE, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.16022)

59 Insight Management Agent: External Tape Drive Status is NORMAL, 
contained in SNMP Varbind 7 for a tape drive. (1.3.6.1.4.1.232.0.16023)

60 Insight Management Agent: External Tape Drive Status is DEGRADED, 
contained in SNMP Varbind 7 for a tape drive. (1.3.6.1.4.1.232.0.16023)

61 Insight Management Agent: External Tape Drive Status is FAILED, 
contained in SNMP Varbind 7 for a tape drive. (1.3.6.1.4.1.232.0.16023)

62 Insight Management Agent: External Tape Drive Status is OFFLINE, 
contained in SNMP Varbind 7 (1.3.6.1.4.1.232.0.16023)

63 Insight Management Agent: External Tape Drive Status is MISSING 
WAS OK, contained in SNMP Varbind 11 (1.3.6.1.4.1.232.0.16023)

64 Insight Management Agent: External Tape Drive Status is MISSING 
WAS OFFLINE, contained in SNMP Varbind 11 (1.3.6.1.4.1.232.0.16023)

65 Insight Management Agent: External Tape Drive cleaning required. 
(1.3.6.1.4.1.232.0.16024)

66 Insight Management Agent: Cleaning tape needs replacing 
(1.3.6.1.4.1.232.0.16025)

67 Insight Management Agent: External Tape Library status is NORMAL, 
contained in SNMP Varbind 11 (1.3.6.1.4.1.232.0.16026)

68 Insight Management Agent: External Tape Library status is 
DEGRADED, contained in SNMP Varbind 11 (1.3.6.1.4.1.232.0.16026)
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69 Insight Management Agent: External Tape Library status is FAILED, 
contained in SNMP Varbind 11 (1.3.6.1.4.1.232.0.16026)

70 Insight Management Agent: External Tape Library status is OFFLINE, 
contained in SNMP Varbind 11 (1.3.6.1.4.1.232.0.16026)

71 Insight Management Agent: External Tape Library door status is OPEN, 
contained in SNMP Varbind 11 (1.3.6.1.4.1.232.0.16027)

72 Insight Management Agent: Fibre Channel Host Controller Status is 
FAILED, status is contained in SNMP Varbind 5 for a host controller 
contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.16028)

73 Insight Management Agent: Fibre Channel Host Controller Status is 
LOOPDEGRADED, contained in SNMP Varbind 5 for a host controller 
contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.16028)

74 Insight Management Agent: Fibre Channel Host Controller Status is 
LOOPFAILED, contained in SNMP Varbind 5 for a host controller 
contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.16028)

75 Insight Management Agent: Fibre Channel Host Controller Status is 
SHUTDOWN, contained in SNMP Varbind 5 for the host controller 
contained in Varbind 3. (1.3.6.1.4.1.232.0.16028)
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HPSIMInt-IMAgents_FwdClusterTraps (uses 
CPQCLUS.MIB)

1 Insight Management Agent: Cluster contained in SNMP Varbind 3 has 
become degraded. (1.3.6.1.4.1.232.0.15001)

2 Insight Management Agent: Cluster contained in SNMP Varbind 3 has 
failed. (1.3.6.1.4.1.232.0.15002)

3 Insight Management Agent: Cluster service on contained in SNMP 
Varbind 3 has become degraded. (1.3.6.1.4.1.232.0.15003)

4 Insight Management Agent: Cluster service on node contained in SNMP 
Varbind 3 has failed. (1.3.6.1.4.1.232.0.15004)

5 Insight Management Agent: Cluster resource contained in SNMP Varbind 
3 has become degraded. (1.3.6.1.4.1.232.0.15005)

6 Insight Management Agent: Cluster resource contained in SNMP Varbind 
3 has failed. (1.3.6.1.4.1.232.0.15006)

7 Insight Management Agent: Cluster network contained in SNMP Varbind 
3 has become degraded. (1.3.6.1.4.1.232.0.15007)

8 Insight Management Agent: Cluster network contained in SNMP Varbind 
3 has failed. (1.3.6.1.4.1.232.0.15008)
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Insight Management Agent SNMP Trap Polices and 
Rules for HPSIMInt-IMAgents_FwdCMCTraps (uses 
CPQCMC.MIB)

1 Insight Management Agent: Temperature in rack sensed by CMC 
temperature sensor 1 is NORMAL, status is contained in SNMP Varbind 
5 (.1.3.6.1.4.1.232.153.0.153001)

2 Insight Management Agent: Temperature in rack sensed by CMC 
temperature sensor 1 has exceeded High Threshold, status is contained in 
SNMP Varbind 5 (.1.3.6.1.4.1.232.153.0.153001)

3 Insight Management Agent: Temperature in rack as sensed by CMC has 
exceeded Warning Threshold, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153001)

4 Insight Management Agent: Temperature in rack as sensed by CMC has 
gone below Minimum Threshold, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153001)

5 Insight Management Agent: Temperature in rack as sensed by CMC has 
exceeded High Threshold, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153002)

6 Insight Management Agent: Temperature in rack as sensed by CMC has 
exceeded Warning Threshold, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153002)

7 Insight Management Agent: Temperature in rack as sensed CMC has 
gone below Minimum Threshold, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153002)

8 Insight Management Agent: Status of Fan 1 in rack is Normal, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153003)

9 Insight Management Agent: Status of Fan 1 in rack is AutoOff, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153003)

10 Insight Management Agent: Status of Fan 1 in rack is SmokeOff, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153003)

11 Insight Management Agent: Status of Fan 1 in rack is DoorOff, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153003)
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12 Insight Management Agent: Status of Fan 2 in rack is AutoOn, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153004)

13 Insight Management Agent: Status of Fan 2 in rack is AutoOff, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153004)

14 Insight Management Agent: Status of Fan 2 in rack is SmokeOff, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153004)

15 Insight Management Agent: Status of Fan 2 in rack is DoorOff, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153004)

16 Insight Management Agent: Status of voltage-supply to CMC is Normal, 
status is contained in SNMP Varbind 5 (.1.3.6.1.4.1.232.153.0.153005)

17 Insight Management Agent: Status of voltage-supply to CMC is OverMax, 
status is contained in SNMP Varbind 5 (.1.3.6.1.4.1.232.153.0.153005)

18 Insight Management Agent: Status of voltage-supply to CMC is 
UnderMin, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153005)

19 Insight Management Agent: Status of humidity is Normal, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153006)

20 Insight Management Agent: Status of humidity is OverMax, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153006)

21 Insight Management Agent: Status of humidity is UnderMin, status is 
contained in SNMP Varbind 5(.1.3.6.1.4.1.232.153.0.153006)

22 Insight Management Agent: Status of door or sidepanel of the rack in 
access point 1 is opened, status is contained in SNMP Varbind 
5(.1.3.6.1.4.1.232.153.0.153007)

23  Insight Management Agent: Status of door or sidepanel of the rack in 
access point 1 is closed, status is contained in SNMP Varbind 
5(.1.3.6.1.4.1.232.153.0.153007)

24 Insight Management Agent: Status of door or sidepanel of the rack in 
access point 2 is opened, status is contained in SNMP Varbind 
5(.1.3.6.1.4.1.232.153.0.153008)

25 Insight Management Agent: Status of door or sidepanel of the rack in 
access point 2 is closed, status is contained in SNMP Varbind 
5(.1.3.6.1.4.1.232.153.0.153008)
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26 Insight Management Agent: Status of door or sidepanel of the rack in 
access point 3 is opened, status is contained in SNMP Varbind 
5(.1.3.6.1.4.1.232.153.0.153009)

27 Insight Management Agent: Status of door or sidepanel of the rack in 
access point 4 is opened, status is contained in SNMP Varbind 
5(.1.3.6.1.4.1.232.153.0.153010)

28 Insight Management Agent: Status of door or sidepanel of the rack in 
access point 4 is closed, status is contained in SNMP Varbind 
5(.1.3.6.1.4.1.232.153.0.153010)

29 Insight Management Agent: Status of rack door locked by locking device 1 
is Locked, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153011)

30 Insight Management Agent: Status of rack door locked by locking device 1 
is Unlocked, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153011)

31 Insight Management Agent: Status of rack door locked by locking device 2 
is Locked, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153012)

32 Insight Management Agent: Status of rack door locked by locking device 2 
is Unlocked, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153012)

33 Insight Management Agent: Status of smoke presence in rack as detected 
by CMC is Normal, the status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153013)

34 Insight Management Agent: Status of smoke presence in rack as detected 
by CMC is Present, the status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153013)

35 Insight Management Agent: Status of shock or vibrations in rack as 
detected by CMC shock sensor is Normal, status is contained in SNMP 
Varbind 5 (.1.3.6.1.4.1.232.153.0.153014)

36 Insight Management Agent: Status of shock or vibrations in rack as 
detected by CMC shock sensor is Present, status is contained in SNMP 
Varbind 5 (.1.3.6.1.4.1.232.153.0.153014)

37 Insight Management Agent: Status of rack auxillary alarm input #1 as 
detected by CMC is Triggered, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153015)
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38 Insight Management Agent: Status of rack auxillary alarm input #1 as 
detected by CMC is ok, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153015)

39 Insight Management Agent: Status of rack auxiliary alarm input #1 as 
detected by CMC is triggered; status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153015)

40 Insight Management Agent: Status of rack auxiliary alarm input #1 as 
detected by CMC is ok, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153015)

41 Insight Management Agent: Status of rack auxillary alarm input #1 as 
detected by CMC is Triggered, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153016)

42 Insight Management Agent: Status of rack auxillary alarm input #1 as 
detected by CMC is ok, status is contained in SNMP Varbind 5 
(.1.3.6.1.4.1.232.153.0.153016)

43 Insight Management Agent: NMS-alarm Status of Alarm1, status is 
contained in SNMP Varbind 5 (.1.3.6.1.4.1.232.153.0.153017)

44 Insight Management Agent: NMS-alarm Status of Alarm2, status is 
contained in SNMP Varbind 5 (.1.3.6.1.4.1.232.153.0.153018)

45 Insight Management Agent: The door locking device 1 needs Normal, 
status is contained in SNMP Varbind 5 (.1.3.6.1.4.1.232.153.0.153019)

46 Insight Management Agent: The door locking device 1 needs attention, 
status is contained in SNMP Varbind 5 (.1.3.6.1.4.1.232.153.0.153019)

47 Insight Management Agent: The door locking device 2 needs Normal, 
status is contained in SNMP Varbind 5 (.1.3.6.1.4.1.232.153.0.153020)

48 Insight Management Agent: The door locking device 2 needs attention, 
status is contained in SNMP Varbind 5 (.1.3.6.1.4.1.232.153.0.153020)
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HPSIMInt-IMAgents_FwdRaidControllerTraps (uses 
CPQCR.MIB)

1 Insight Management Agent: The primary controller in the subsystem has 
failed. (1.3.6.1.4.1.232.141.3.2.0.1)

2 Insight Management Agent: The primary controller in the subsystem has 
recovered. (1.3.6.1.4.1.232.141.3.2.0.2)

3 Insight Management Agent: The secondary controller in the subsystem 
has failed. (1.3.6.1.4.1.232.141.3.2.0.3)

4 Insight Management Agent: The secondary controller in the subsystem 
has recovered. (1.3.6.1.4.1.232.141.3.2.0.4)

5 Insight Management Agent: The RAIDset has failed and is off-line. 
(1.3.6.1.4.1.232.141.3.3.0.6)

6 Insight Management Agent: A RAID set has started the reconstruction 
process. (1.3.6.1.4.1.232.141.3.3.0.7)

7 Insight Management Agent: The RAIDset has become degraded. 
(1.3.6.1.4.1.232.141.3.3.0.8)

8 Insight Management Agent: A disk device has recovered. 
(1.3.6.1.4.1.232.141.3.5.0.10)

9 Insight Management Agent: A disk device has failed. 
(1.3.6.1.4.1.232.141.3.5.0.11)

10 Insight Management Agent: A disk device has recovered. 
(1.3.6.1.4.1.232.141.3.5.0.30)

11 Insight Management Agent: A disk device has failed. 
(1.3.6.1.4.1.232.141.3.5.0.31)

12 Insight Management Agent: One of the cooling fans in the primary 
enclosure has failed. (1.3.6.1.4.1.232.141.3.7.0.16)

13 Insight Management Agent: One of the cooling fans in the primary 
enclosure has recovered. (1.3.6.1.4.1.232.141.3.7.0.17)

14 Insight Management Agent: One of the power supplies in the primary 
enclosure has failed. (1.3.6.1.4.1.232.141.3.7.0.18)

15 Insight Management Agent: One of the power supplies in the primary 
enclosure has recovered. (1.3.6.1.4.1.232.141.3.7.0.19)
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16 Insight Management Agent: The temperature in the primary enclosure 
has triggered a critical condition detected by the controller. 
(1.3.6.1.4.1.232.141.3.7.0.24)

17 Insight Management Agent: The temperature in the primary enclosure 
has returned to normal. (1.3.6.1.4.1.232.141.3.7.0.25)

18 Insight Management Agent: One of the cooling fans in the expansion 
cabinet has failed. (1.3.6.1.4.1.232.141.3.8.0.20)

19 Insight Management Agent: One of the cooling fans in the expansion 
cabinet has recovered. (1.3.6.1.4.1.232.141.3.8.0.21)

20 Insight Management Agent: One of the power supplies in the expansion 
cabinet has failed. (1.3.6.1.4.1.232.141.3.8.0.22)

21 Insight Management Agent: One of the power supplies in the expansion 
cabinet has recovered. (1.3.6.1.4.1.232.141.3.8.0.29)

22 Insight Management Agent: The temperature in the expansion cabinet 
has triggered a critical condition detected by the controller. 
(1.3.6.1.4.1.232.141.3.8.0.27)

23 Insight Management Agent: The temperature in the expansion cabinet 
has returned to normal. (1.3.6.1.4.1.232.141.3.8.0.28)
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HPSIMInt-IMAgents_FwdDMITraps (uses 
CPQDMII.mib)

1 Insight Management Agent: DMI Informational Indication occurred on 
SNMP Varbind 2 of type SNMP Varbind 8 for (SNMP Varbind 4,SNMP 
Varbind 5) (1.3.6.1.4.1.232.0.150001)

2 Insight Management Agent: DMI Monitor Indication occurred on SNMP 
Varbind 2 of type SNMP Varbind 8 for (SNMP Varbind 4,SNMP Varbind 
5) (1.3.6.1.4.1.232.0.150002)

3 Insight Management Agent: DMI OK Indication occurred on SNMP 
Varbind 2 of type SNMP Varbind 8 for (SNMP Varbind 4,SNMP Varbind 
5) (.1.3.6.1.4.1.232.0.150003)

4 Insight Management Agent: DMI NonCritical Indication occurred on 
SNMP Varbind 2 of type SNMP Varbind 8 for (SNMP Varbind 4>,SNMP 
Varbind 5) (.1.3.6.1.4.1.232.0.150004)

5 Insight Management Agent: DMI Critical Indication occurred on SNMP 
Varbind 2 of type SNMP Varbind 8 for (SNMP Varbind 4,SNMP Varbind 
5) (.1.3.6.1.4.1.232.0.150005)

6 Insight Management Agent: DMI NonRecoverable Indication occurred on 
SNMP Varbind 2 of type SNMP Varbind 8 for (SNMP Varbind 4,SNMP 
Varbind 5) (.1.3.6.1.4.1.232.0.150006)
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HPSIMInt-IMAgents_FwdSvrHealthTraps (uses 
CPQHLTH.MIB)

1 Insight Management Agent: A correctable memory error has occurred. 
(1.3.6.1.4.1.232.0.6001)

2 Insight Management Agent: Too many memory errors tracking now 
disabled. (1.3.6.1.4.1.232.0.6002)

3 Insight Management Agent: System will be shutdown due to this thermal 
condition. (1.3.6.1.4.1.232.0.6003)

4  Insight Management Agent: Temperature out of range. Shutdown may 
occur. (1.3.6.1.4.1.232.0.6004)

5  Insight Management Agent: Temperature has returned to normal range. 
(1.3.6.1.4.1.232.0.6005)

6 Insight Management Agent: Required fan not operating normally. 
Shutdown may occur. (1.3.6.1.4.1.232.0.6006)

7 Insight Management Agent: An optional fan is not operating normally. 
(1.3.6.1.4.1.232.0.6007)

8 Insight Management Agent: System fan has returned to normal operation. 
(1.3.6.1.4.1.232.0.6008)

9 Insight Management Agent: CPU fan has failed. Server will be shutdown. 
(1.3.6.1.4.1.232.0.6009)

10 Insight Management Agent: CPU fan is now OK. (1.3.6.1.4.1.232.0.6010)

11 Insight Management Agent: Server is operational again after ASR 
shutdown. (1.3.6.1.4.1.232.0.6011)

12 Insight Management Agent: Server is operational again after thermal 
shutdown. (1.3.6.1.4.1.232.0.6012)

13 Insight Management Agent: Errors occurred during server restart. 
(1.3.6.1.4.1.232.0.6013)

14 Insight Management Agent: The server power supply status has become 
degraded. (1.3.6.1.4.1.232.0.6014)

15 Insight Management Agent: A correctable memory error has occurred. 
(1.3.6.1.4.1.232.0.6015)
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16 Insight Management Agent: Too many memory errors tracking now 
disabled. (1.3.6.1.4.1.232.0.6016)

17 Insight Management Agent: Error tracking is now enabled. 
(1.3.6.1.4.1.232.0.6016)

18 Insight Management Agent: System will be shutdown due to this thermal 
condition. (1.3.6.1.4.1.232.0.6017)

19 Insight Management Agent: Thermal condition has degraded. 
(1.3.6.1.4.1.232.0.6018)

20 Insight Management Agent: Temperature out of range. Shutdown may 
occur. (1.3.6.1.4.1.232.0.6018)

21 Insight Management Agent: Temperature has returned to normal range. 
(1.3.6.1.4.1.232.0.6019)

22 Insight Management Agent: Required fan not operating normally. 
(1.3.6.1.4.1.232.0.6020)

23 Insight Management Agent: System fan has failed. 
(1.3.6.1.4.1.232.0.6020)

24 Insight Management Agent: An optional fan is not operating normally. 
(1.3.6.1.4.1.232.0.6021)

25 Insight Management Agent: System fan has returned to normal operation. 
(1.3.6.1.4.1.232.0.6022)

26 Insight Management Agent: CPU fan has failed. Server will be shutdown. 
(1.3.6.1.4.1.232.0.6023)

27 Insight Management Agent: CPU fan is now OK. (1.3.6.1.4.1.232.0.6024)

28 Insight Management Agent: Server is operational again after ASR 
shutdown. (1.3.6.1.4.1.232.0.6025)

29 Insight Management Agent: Server is operational again after thermal 
shutdown. (1.3.6.1.4.1.232.0.6026)

30 Insight Management Agent: Errors occurred during server restart. 
(1.3.6.1.4.1.232.0.6027)

31 Insight Management Agent: The server power supply status has become 
degraded. (1.3.6.1.4.1.232.0.6028)

32 Insight Management Agent: Correctable memory errors require a 
replacement memory module. (1.3.6.1.4.1.232.0.6029)
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33 Insight Management Agent: The Power Supply Degraded on Chassis 
contained in SNMP Varbind 3, Bay contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.6030)

34 Insight Management Agent: The Power Supply Failed on Chassis 
contained in SNMP Varbind 3, Bay contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.6031)

35 Insight Management Agent: The Power Supplies are no longer redundant 
on Chassis contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.6032)

36 Insight Management Agent: The Power Supply Inserted on Chassis 
contained in SNMP Varbind 3, Bay contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.6033)

37 Insight Management Agent: The Power Supply Removed on Chassis 
contained in SNMP Varbind 3, Bay contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.6034)

38 Insight Management Agent: The Fan Degraded on Chassis contained in 
SNMP Varbind 3, Fan contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.6035)

39 Insight Management Agent: The Fan Failed on Chassis contained in 
SNMP Varbind 3, Fan contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.6036)

40 Insight Management Agent: The Fans are no longer redundant on Chassis 
contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.6037)

41 Insight Management Agent: The Fan Inserted on Chassis contained in 
SNMP Varbind 3, Fan contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.6038)

42 Insight Management Agent: The Fan Removed on Chassis contained in 
SNMP Varbind 3, Fan contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.6039)

43 Insight Management Agent: Temperature Exceeded on Chassis contained 
in SNMP Varbind 3, Location contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.6040)

44 Insight Management Agent: Temperature status has degraded on Chassis 
contained in SNMP Varbind 4, Location contained in SNMP Varbind 5. 
(1.3.6.1.4.1.232.0.6041)
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45 Insight Management Agent: Temperature out of range on Chassis 
contained in SNMP Varbind 4, Location contained in SNMP Varbind 5. 
Shutdown may occur soon. (1.3.6.1.4.1.232.0.6041)

46 Insight Management Agent: Temperature Normal on Chassis contained in 
SNMP Varbind 3, Location contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.6042)

47 Insight Management Agent: Power Converter Degraded on Chassis in 
SNMP Varbind 3, Slot in SNMP Varbind 4, Socket in SNMP Varbind 5. 
(1.3.6.1.4.1.232.0.6043)

48 Insight Management Agent: Power Converter Failed on Chassis in SNMP 
Varbind 3, Slot in SNMP Varbind 4, Socket in SNMP Varbind 5. 
(1.3.6.1.4.1.232.0.6044)

49 Insight Management Agent: Power Converters are no longer redundant on 
Chassis contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.6045)

50 Insight Management Agent: Cache Accelerator errors may require a 
replacement module. (1.3.6.1.4.1.232.0.6046)

51  Insight Management Agent: The Resilient Memory subsystem has 
engaged the online spare memory. (1.3.6.1.4.1.232.0.6047)

52 Insight Management Agent: The Power Supply is OK on Chassis in SNMP 
Varbind 3 (1.3.6.1.4.1.232.0.6048)

53 Insight Management Agent: The Power Supply is degraded on Chassis in 
SNMP Varbind 3 (1.3.6.1.4.1.232.0.6049)

54 Insight Management Agent: The Power Supply is failed on Chassis in 
SNMP Varbind 3 (1.3.6.1.4.1.232.0.6050)

55 Insight Management Agent: Advanced Memory Protection Mirrored 
Memory Engaged (1.3.6.1.4.1.232.0.6051)

56 Insight Management Agent: Advanced Memory Protection Advanced ECC 
Memory Engaged (1.3.6.1.4.1.232.0.6052)

57 Insight Management Agent: Advanced Memory Protection XOR Engine 
Memory Engaged (1.3.6.1.4.1.232.0.6053)

58 Insight Management Agent: Fault Tolerant Power Supplies Power 
Redundancy Restored (1.3.6.1.4.1.232.0.6054)

59 Insight Management Agent: Fault Tolerant Fans Fan Redundancy 
Restored (1.3.6.1.4.1.232.0.6055)
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60 Insight Management Agent: Correctable memory errors require a 
replacement memory module. (1.3.6.1.4.1.232.0.6056)

61 Insight Management Agent: Memory board or cartridge removed 
(1.3.6.1.4.1.232.0.6057)

62 Insight Management Agent: Memory board or cartridge inserted 
(1.3.6.1.4.1.232.0.6058)

63 Insight Management Agent: Memory board or cartridge bus error detected 
(1.3.6.1.4.1.232.0.6059)

64 Insight Management Agent: Too many memory errors tracking now 
disabled. (1.3.6.1.4.1.232.6.0.2)

65 The Management processor is in the process of being reset 
(1.3.6.1.4.1.232.0.6061)

66 Insight Management Agent: The Management processor is ready after a 
successfully reset (1.3.6.1.4.1.232.0.6062)
SNMP Trap Interceptor Policies 133



HPSIMInt-IMAgents_FwdHostOSTraps (uses 
CPQHOST.MIB)

1 Insight Management Agent: Generic Trap received 
(1.3.6.1.4.1.232.0.11001)

2 Insight Management Agent: Application Error Trap 
(1.3.6.1.4.1.232.0.11002)

3 Insight Management Agent: Generic Trap Received 
(1.3.6.1.4.1.232.0.11003)

4 Insight Management Agent: Application Error Trap 
(1.3.6.1.4.1.232.0.11004)

5 Insight Management Agent: NIC Status is OK (1.3.6.1.4.1.232.0.11005)

6 Insight Management Agent: NIC Status is Failed (1.3.6.1.4.1.232.0.11006)

7 Insight Management Agent: NIC switchover occurred 
(1.3.6.1.4.1.232.0.11007)

8 Insight Management Agent: NIC Status is OK (1.3.6.1.4.1.232.0.11008)

9 Insight Management Agent: NIC Status is Failed (1.3.6.1.4.1.232.0.11009)

10 Insight Management Agent: NIC switchover (1.3.6.1.4.1.232.0.11010)

11 Insight Management Agent: Process monitor event trap received 
(1.3.6.1.4.1.232.0.11011)

12 Insight Management Agent: Process Count event trap received 
(1.3.6.1.4.1.232.0.11012)

13 Insight Management Agent: Process monitor event trap received 
(1.3.6.1.4.1.232.0.11013)

14 Insight Management Agent: Critical software update trap received 
(1.3.6.1.4.1.232.0.11014)

15 Insight Management Agent: Crash Dump is not enabled 
(1.3.6.1.4.1.232.0.11015)

16 Insight Management Agent: The paging file size of the boot volume (%s) or 
the target volume of the memory dump file is not large enough to hold a 
crash dump in the event of a system crash (1.3.6.1.4.1.232.0.11016)
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HPSIMInt-IMAgents_FwdICATraps (uses CPQICA.MIB)

1 Insight Management Agent: Intelligent Cluster Administrator added an 
object to the cluster. (1.3.6.1.4.1.232.0.140001)

2 Insight Management Agent: Intelligent Cluster Administrator has deleted 
an object in the cluster. (1.3.6.1.4.1.232.0.140002)

3 Insight Management Agent: Intelligent Cluster Administrator has 
performed one or more property changes on the cluster. 
(1.3.6.1.4.1.232.0.140003)

4 Insight Management Agent: Intelligent Cluster Administrator has 
performed a move action on the cluster. (1.3.6.1.4.1.232.0.140004)

5 Insight Management Agent: Intelligent Cluster Administrator is starting 
an import operation on the cluster. (1.3.6.1.4.1.232.0.140005)

6 Insight Management Agent: Intelligent Cluster Administrator has 
finished an import operation on the cluster. (1.3.6.1.4.1.232.0.140006)
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HPSIMInt-IMAgents_FwdDriveArrayTraps (uses 
CPQIDA.MIB)

1 Insight Management Agent: Intelligent DriveArray Logical Drive status is 
NORMAL, contained in SNMP Varbind 1. (1.3.6.1.4.1.232.0.3001)

2 Insight Management Agent: Intelligent DriveArray Logical Drive status is 
FAILED, contained in SNMP Varbind 1. (1.3.6.1.4.1.232.0.3001)

3 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is RECOVERING, contained in SNMP Varbind 1. (1.3.6.1.4.1.232.0.3001)

4 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is READY for REBUILD, contained in SNMP Varbind 1 
(1.3.6.1.4.1.232.0.3001)

5 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is REBUILDING, contained in SNMP Varbind 1 (1.3.6.1.4.1.232.0.3001)

6 Insight Management Agent:Intelligent Drive Array Logical Drive status is 
WRONG DRIVE, contained in SNMP Varbind 1. (1.3.6.1.4.1.232.0.3001)

7 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is BAD CONNECTION, contained in SNMP Varbind 1. 
(1.3.6.1.4.1.232.0.3001)

8 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is OVERHEATING, contained in SNMP Varbind 1. 
(1.3.6.1.4.1.232.0.3001)

9 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is SHUTDOWN, contained in SNMP Varbind 1. (1.3.6.1.4.1.232.0.3001)

10 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is UNAVAILABLE, status is contained in SNMP Varbind 1. 
(1.3.6.1.4.1.232.0.3001)

11 Insight Management Agent: Intelligent Drive Array Spare Drive status is 
ACTIVE, status is contained in SNMP Varbind 1 (1.3.6.1.4.1.232.0.3002)

12 Insight Management Agent: Intelligent Drive Array Spare Drive status is 
FAILED, status is contained in SNMP Varbind 1 (1.3.6.1.4.1.232.0.3002)

13 Insight Management Agent: Intelligent Drive Array Spare Drive status is 
BUILDING, status is contained in SNMP Varbind 1. 
(1.3.6.1.4.1.232.0.3002)
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14 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is OK, contained in SNMP Varbind 1. (1.3.6.1.4.1.232.0.3003)

15 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is FAILED, contained in SNMP Varbind 1. (1.3.6.1.4.1.232.0.3003)

16 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is PREDICTIVEFAILURE, status is contained in SNMP Varbind 1. 
(1.3.6.1.4.1.232.0.3003)

17 Insight Management Agent: Intelligent Drive Array Physical Drive 
threshold passed, status is contained in SNMP Varbind 1. 
(1.3.6.1.4.1.232.0.3004)

18 Insight Management Agent: Intelligent Drive Array Accelerator Board 
status is TEMPORARILY DISABLED, status is contained in SNMP 
Varbind 1. (1.3.6.1.4.1.232.0.3005)

19 Insight Management Agent: Intelligent Drive Array Accelerator Board 
status is PERMANENTLY DISABLED, contained in SNMP Varbind 1. 
(1.3.6.1.4.1.232.0.3005)

20 Insight Management Agent: Intelligent Drive Array Accelerator lost 
battery power. Data Loss possible. (1.3.6.1.4.1.232.0.3006)

21 Insight Management Agent: Intelligent Drive Array Accelerator Board 
Battery status is OK. Status is contained in SNMP Varbind 1 
(1.3.6.1.4.1.232.0.3007)

22 Insight Management Agent: Intelligent Drive Array Accelerator Board 
Battery status is failed. Status is contained in SNMP Varbind 1 
(1.3.6.1.4.1.232.0.3007)

23 Insight Management Agent: Intelligent Drive Array Accelerator Board 
Battery status is degraded. Status is contained in SNMP Varbind 1 
(1.3.6.1.4.1.232.0.3007)

24 Insight Management Agent: Intelligent DriveArray Logical Drive status is 
NORMAL, contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.3008)

25 Insight Management Agent: Intelligent DriveArray Logical Drive status is 
FAILED, contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.3008)

26 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is RECOVERING, contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.3008)
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27 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is READY for REBUILD, contained in SNMP Varbind 3 
(1.3.6.1.4.1.232.0.3008)

28  Insight Management Agent: Intelligent Drive Array Logical Drive status 
is REBUILDING, contained in SNMP Varbind 3 (1.3.6.1.4.1.232.0.3008)

29  Insight Management Agent:Intelligent Drive Array Logical Drive status 
is WRONG DRIVE, contained in SNMP Varbind 3 (1.3.6.1.4.1.232.0.3008)

30  Insight Management Agent: Intelligent Drive Array Logical Drive status 
is BAD CONNECTION, contained in SNMP Varbind 3 
(1.3.6.1.4.1.232.0.3008)

31 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is OVERHEATING, contained in SNMP Varbind 3. 
(1.3.6.1.4.1.232.0.3008)

32  Insight Management Agent: Intelligent Drive Array Logical Drive status 
is SHUTDOWN, contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.3008)

33 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is UNAVAILABLE, status is contained in SNMP Varbind 3. 
(1.3.6.1.4.1.232.0.3008)

34 Insight Management Agent: Intelligent Drive Array Spare Drive status is 
ACTIVE, status is contained in SNMP Varbind 3 (1.3.6.1.4.1.232.0.3009)

35 Insight Management Agent: Intelligent Drive Array Spare Drive status is 
FAILED, status is contained in SNMP Varbind 3 (1.3.6.1.4.1.232.0.3009)

36 Insight Management Agent: Intelligent Drive Array Spare Drive status is 
BUILDING, status is contained in SNMP Varbind 3. 
(1.3.6.1.4.1.232.0.3009)

37 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is OK, contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.3010)

38 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is FAILED, contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.3010)

39 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is PREDICTIVEFAILURE, status is contained in SNMP Varbind 3 
(1.3.6.1.4.1.232.0.3010)

40 Insight Management Agent: Intelligent Drive Array Physical Drive 
threshold passed, status is contained in SNMP Varbind 3. 
(1.3.6.1.4.1.232.0.3011)
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41 Insight Management Agent: Intelligent Drive Array Accelerator Board 
status is TEMPORARILY DISABLED, status is contained in SNMP 
Varbind 3. (1.3.6.1.4.1.232.0.3012)

42 Insight Management Agent: Intelligent Drive Array Accelerator Board 
status is PERMANENTLY DISABLED, contained in SNMP Varbind 3. 
(1.3.6.1.4.1.232.0.3012)

43 Insight Management Agent: Intelligent Drive Array Accelerator lost 
battery power. Data Loss possible. (1.3.6.1.4.1.232.0.3013)

44 Insight Management Agent: Intelligent Drive Array Accelerator Board 
Battery status is OK. Status is contained in SNMP Varbind 3 
(1.3.6.1.4.1.232.0.3014)

45 Insight Management Agent: Intelligent Drive Array Accelerator Board 
Battery status is failed. Status is contained in SNMP Varbind 3 
(1.3.6.1.4.1.232.0.3014)

46  Insight Management Agent: Intelligent Drive Array Accelerator Board 
Battery status is degraded. Status is contained in SNMP Varbind 3 
(1.3.6.1.4.1.232.0.3014)

47 Insight Management Agent: Intelligent Drive Array Controller status is 
FAILED, status is contained in SNMP Varbind 4. (1.3.6.1.4.1.232.0.3015)

48 Insight Management Agent: Intelligent Drive Array Controller has cable 
problem, status is contained in SNMP Varbind 4. (1.3.6.1.4.1.232.0.3015)

49 Insight Management Agent: Intelligent Drive Array Controller is powered 
off, status is contained in SNMP Varbind 4. (1.3.6.1.4.1.232.0.3015)

50  Insight Management Agent: Intelligent Drive Array Spare Drive status is 
ACTIVE, status is contained in SNMP Varbind 3 (1.3.6.1.4.1.232.0.3017)

51 Insight Management Agent: Intelligent Drive Array Spare Drive status is 
FAILED, status is contained in SNMP Varbind 3 (1.3.6.1.4.1.232.0.3017)

52 Insight Management Agent: Intelligent Drive Array Spare Drive status is 
BUILDING, status is contained in SNMP Varbind 1. 
(1.3.6.1.4.1.232.0.3017)

53 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is OK, contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.3018)

54  Insight Management Agent: Intelligent Drive Array Physical Drive 
status is FAILED, contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.3018)
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55 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is PREDICTIVEFAILURE, status is contained in SNMP Varbind 3. 
(1.3.6.1.4.1.232.0.3018)

56 Insight Management Agent: Intelligent Drive Array Physical Drive 
threshold passed (1.3.6.1.4.1.232.0.3019)

57  Insight Management Agent: Intelligent Drive ArrayTape Library status 
is OK, status is contained in SNMP Varbind 7 for the tape library. 
(1.3.6.1.4.1.232.0.3020)

58 Insight Management Agent: Intelligent Drive ArrayTape Library status is 
FAILED, status is contained in SNMP Varbind 7 for the tape library. 
(1.3.6.1.4.1.232.0.3020)

59  Insight Management Agent: Intelligent Drive ArrayTape Library status 
is DEGRADED, status is contained in SNMP Varbind 7 for the tape 
library. (1.3.6.1.4.1.232.0.3020)

60  Insight Management Agent: Intelligent Drive Array Tape Library Door 
Status is OPEN, status is contained in SNMP Varbind 7 
(1.3.6.1.4.1.232.0.3021)

61 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
DEGRADED, status is contained in SNMP Varbind 7 
(1.3.6.1.4.1.232.0.3022)

62 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
FAILED, status is contained in SNMP Varbind 7 (1.3.6.1.4.1.232.0.3022)

63 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
OFFLINE, status is contained in SNMP Varbind 7 (1.3.6.1.4.1.232.0.3022)

64 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
MISSING WAS OK, status is contained in SNMP Varbind 7 
(1.3.6.1.4.1.232.0.3022)

65 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
MISSING WAS OFFLINE, status is contained in SNMP Varbind 7 
(1.3.6.1.4.1.232.0.3022)

66 Insight Management Agent: Intelligent Drive Array Tape Drive cleaning 
is required. (1.3.6.1.4.1.232.0.3023)

67 Insight Management Agent: Cleaning tape needs replacing 
(1.3.6.1.4.1.232.0.3024)
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68 Insight Management Agent: Intelligent Drive Array Accelerator Board 
status is TEMPORARILY DISABLED, status is contained in SNMP 
Varbind 7. (1.3.6.1.4.1.232.0.3025)

69 Insight Management Agent: Intelligent Drive Array Accelerator Board 
status is PERMANENTLY DISABLED, status is contained in SNMP 
Varbind 7. (1.3.6.1.4.1.232.0.3025)

70 Insight Management Agent: Intelligent Drive Array Accelerator lost 
battery power. Data Loss possible. (1.3.6.1.4.1.232.0.3026)

71 Insight Management Agent: Intelligent Drive Array Accelerator battery 
failed (1.3.6.1.4.1.232.0.3027)

72 Insight Management Agent: Intelligent Drive Array Controller Board has 
failed, status is contained in SNMP Varbind 4. (1.3.6.1.4.1.232.0.3028)

73 Insight Management Agent: Intelligent Drive Array Controller Board has 
cable problem, status is contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.3028)

74 Insight Management Agent: Intelligent Drive Array Controller Board is 
POWER OFF, status is contained in SNMP Varbind 4. 
(1.2.6.1.4.1.232.0.3028)

75 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is OK, contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.3029)

76 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is FAILED, contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.3029)

77 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is PREDICTIVEFAILURE, status is contained in SNMP Varbind 3. 
(1.3.6.1.4.1.232.0.3029)

78 Insight Management Agent: Intelligent Drive Array Physical Drive 
threshold passed (1.3.6.1.4.1.232.0.3030)

79 Insight Management Agent: Intelligent Drive ArrayTape Library status is 
FAILED, status is contained in SNMP Varbind 7 for the tape library. 
(1.3.6.1.4.1.232.0.3031)

80 Insight Management Agent: Intelligent Drive ArrayTape Library status is 
OK, status is contained in SNMP Varbind 10 for the tape library. 
(1.3.6.1.4.1.232.0.3031)
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81 Insight Management Agent: Intelligent Drive ArrayTape Library status is 
DEGRADED, status is contained in SNMP Varbind 10 for the tape 
library. (1.3.6.1.4.1.232.0.3031)

82 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is EXPANDING, status is contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.3034)

83 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
DEGRADED, status is contained in SNMP Varbind 7 
(1.3.6.1.4.1.232.0.3032)

84 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
FAILED, status is contained in SNMP Varbind 10 (1.3.6.1.4.1.232.0.3032)

85 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
MISSING WAS OK, status is contained in SNMP Varbind 10 
(1.3.6.1.4.1.232.0.3032)

86 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
MISSING WAS OFFLINE, status is contained in SNMP Varbind 10 
(1.3.6.1.4.1.232.0.3032)

87 Insight Management Agent: Intelligent Drive Array Controller status is 
GENERAL FAILURE, status is contained in SNMP Varbind 5 
(1.3.6.1.4.1.232.0.3033)

88 Insight Management Agent: Intelligent Drive Array Controller has a 
CABLE PROBLEM, status is contained in SNMP Varbind 5 
(1.3.6.1.4.1.232.0.3033)

89 Insight Management Agent: Intelligent Drive Array Controller is 
POWERED OFF, status is contained in SNMP Varbind 5 
(1.3.6.1.4.1.232.0.3033)

90 Insight Management Agent: Intelligent Drive Array Controller is OK, 
status is contained in SNMP Varbind 5 (1.3.6.1.4.1.232.0.3033)

91 Insight Management Agent: Intelligent DriveArray Logical Drive status is 
FAILED, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.3034)

92 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is RECOVERING, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.3034)

93 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is READY for REBUILD, contained in SNMP Varbind 6 
(1.3.6.1.4.1.232.0.3034)
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94 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is REBUILDING, contained in SNMP Varbind 6 (1.3.6.1.4.1.232.0.3034)

95 Insight Management Agent:Intelligent Drive Array Logical Drive status is 
WRONG DRIVE, contained in SNMP Varbind 6 (1.3.6.1.4.1.232.0.3034)

96 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is BAD CONNECTION, contained in SNMP Varbind 6 
(1.3.6.1.4.1.232.0.3034)

97 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is OVERHEATING, contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.3034)

98 Insight Management Agent: Intelligent Drive Array Logical Drive status 
is SHUTDOWN, contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.3034)

99 Insight Management Agent: Intelligent Drive Array Accelerator Board 
status is TEMPORARILY DISABLED, status is contained in SNMP 
Varbind 8 (1.3.6.1.4.1.232.0.3038)

100 Insight Management Agent: Intelligent Drive Array Spare Drive status is 
ACTIVE, status is contained in SNMP Varbind 6 (1.3.6.1.4.1.232.0.3035)

101 Insight Management Agent: Intelligent Drive Array Spare Drive status is 
FAILED, status is contained in SNMP Varbind 6 (1.3.6.1.4.1.232.0.3035)

102  Insight Management Agent: Intelligent Drive Array Spare Drive status is 
BUILDING, status is contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.3035)

103 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is OK, contained in SNMP Varbind 12. (1.3.6.1.4.1.232.0.3036)

104  Insight Management Agent: Intelligent Drive Array Physical Drive 
status is FAILED, contained in SNMP Varbind 12. (1.3.6.1.4.1.232.0.3036)

105 Insight Management Agent: Intelligent Drive Array Physical Drive status 
is PREDICTIVEFAILURE, status is contained in SNMP Varbind 12. 
(1.3.6.1.4.1.232.0.3036)

106 Insight Management Agent: Intelligent Drive Array Physical Drive 
threshold passed, the physical drive index is contained in SNMP Varbind 
5. (1.3.6.1.4.1.232.0.3037)

107 Insight Management Agent: Intelligent Drive Array Accelerator Board 
status is PERMANENTLY DISABLED, contained in SNMP Varbind 8. 
(1.3.6.1.4.1.232.0.3038)
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108 Insight Management Agent: Intelligent Drive Array Accelerator Board 
status is TEMPORARILY DISABLED, status is contained in SNMP 
Varbind 8 (1.3.6.1.4.1.232.0.3038)

109 Insight Management Agent: Intelligent Drive ArrayTape Library status is 
OK, status is contained in SNMP Varbind 11 for the tape library. 
(1.3.6.1.4.1.232.0.3041)

110 Insight Management Agent: Intelligent Drive ArrayTape Library status is 
DEGRADED, status is contained in SNMP Varbind 11 for the tape 
library. (1.3.6.1.4.1.232.0.3041)

111 Insight Management Agent: Spare Status has changed. 
(1.3.6.1.4.1.232.0.3047)

112 Insight Management Agent: Intelligent Drive Array Tape Library Door 
Status is OPEN, status is contained in SNMP Varbind 11 
(1.3.6.1.4.1.232.0.3042)

113 Insight Management Agent: Intelligent Drive Array Tape Drive status is 
DEGRADED, status is contained in SNMP Varbind 11 
(1.3.6.1.4.1.232.0.3043)

114 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
FAILED, status is contained in SNMP Varbind 11 (1.3.6.1.4.1.232.0.3043)

115 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
OFFLINE, status is contained in SNMP Varbind 
11(1.3.6.1.4.1.232.0.3043)

116 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
MISSING WAS OK, status is contained in SNMP Varbind 
11(1.3.6.1.4.1.232.0.3043)

117 Insight Management Agent: Intelligent Drive Array Tape Drive Status is 
MISSING WAS OFFLINE, status is contained in SNMP Varbind 11 
(1.3.6.1.4.1.232.0.3043)

118 Insight Management Agent: Intelligent Drive Array Tape Drive cleaning 
is required. (1.3.6.1.4.1.232.0.3044)

119 Insight Management Agent: Cleaning tape needs replacing 
(1.3.6.1.4.1.232.0.3045)

120 Insight Management Agent: Physical Drive Status has changed 
(1.3.6.1.4.1.232.0.3046)
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121 Insight Management Agent: Spare Status has changed 
(1.3.6.1.4.1.232.0.3047)
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HPSIMInt-IMAgents_FwdIDEDriveTraps (uses 
CPQIDE.MIB)

1 Insight Management Agent: IDE drive contained in SNMP Varbind 3 has 
become degraded. (1.3.6.1.4.1.232.0.14001)

2 Insight Management Agent: IDE drive contained in SNMP Varbind 3 has 
returned to normal operating condition. (1.3.6.1.4.1.232.0.14002)

3 Insight Management Agent: IDE drive contained in SNMP Varbind 3 has 
detected Ultra ATA errors. (1.3.6.1.4.1.232.0.14003)

4 Insight Management Agent: Status of an ATA disk has changed to 
NORMAL, status is contained in SNMP Varbind 8. 
(1.3.6.1.4.1.232.0.14004)

5 Insight Management Agent: Status of an ATA disk has changed to 
SMART ERROR, status is contained in SNMP Varbind 8. 
(1.3.6.1.4.1.232.0.14004)

6 Insight Management Agent: Status of an ATA disk has changed to 
FAILED, status is contained in SNMP Varbind 8. (1.3.6.1.4.1.232.0.14004)

7 Insight Management Agent: Status of an IDE logical drive has changed to 
NORMAL, status is contained in SNMP Varbind 7 for the IDE logical 
drive. (1.3.6.1.4.1.232.0.14005)

8 Insight Management Agent: Status of an IDE logical drive has changed to 
DEGRADED, status is contained in SNMP Varbind 7 for the IDE logical 
drive. (1.3.6.1.4.1.232.0.14005)

9 Insight Management Agent: Status of an IDE logical drive has changed to 
REBUILDING, status is contained in SNMP Varbind 7 for the IDE logical 
drive. (1.3.6.1.4.1.232.0.14005)

10 Insight Management Agent: Status of an IDE logical drive has changed to 
FAILED, status is contained in SNMP Varbind 7 for the IDE logical drive. 
(1.3.6.1.4.1.232.0.14005)
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HPSIMInt-IMAgents_FwdNICTraps (uses CPQNIC.MIB)

1 Insight Management Agent: Connectivity is restored for logical adapter in 
slot contained in SNMP Varbind 3, port contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.18001)

2 Insight Management Agent: Connectivity lost for logical adapter in slot 
contained in SNMP Varbind 3, port contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.18002)

3 Insight Management Agent: Physical adapter connection restored in slot 
contained in SNMP Varbind 3, port contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.18003)

4 Insight Management Agent: Physical adapter connection failed in slot 
contained in SNMP Varbind 3, port contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.18004)

5 Insight Management Agent: Connectivity is restored for logical adapter in 
slot contained in SNMP Varbind 3, port contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.18005)

6 Insight Management Agent: Connectivity lost for logical adapter in slot 
contained in SNMP Varbind 3, port contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.18006)

7 Insight Management Agent: Physical adapter connection restored in slot 
contained in SNMP Varbind 3, port contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.18007)

8 Insight Management Agent: Physical adapter connection failed in slot 
contained in SNMP Varbind 3, port contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.18008)

9 Insight Management Agent: The Virus Throttle Filter Driver has detected 
a Virus Activity. (1.3.6.1.4.1.232.0.18009)

10 Insight Management Agent: Virus Throttle Filter Driver no longer detects 
Virus like activity. (1.3.6.1.4.1.232.0.16010)
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HPSIMInt-IMAgents_FwdRackTraps (uses 
CPQRACK.MIB)

1 Insight Management Agent: The rack name has changed to value 
contained in SNMP Varbind 3 (.1.3.6.1.4.1.232.0.22001)

2 Insight Management Agent: The enclosure name has changed to SNMP 
Varbind 5 in rack SNMP Varbind 3 (.1.3.6.1.4.1.232.0.22002)

3 Insight Management Agent: The enclosure in SNMP Varbind 5 has been 
removed from rack SNMP Varbind 3. (.1.3.6.1.4.1.232.0.22003)

4 Insight Management Agent: The enclosure in SNMP Varbind 5 has been 
inserted into rack SNMP Varbind 3 (.1.3.6.1.4.1.232.0.22004)

5 Insight Management Agent: The enclosure in SNMP Varbind 5 
temperature sensor in rack SNMP Varbind 3 has been set to failed. 
(.1.3.6.1.4.1.232.0.22005)

6 Insight Management Agent: The enclosure in SNMP Varbind 5 
temperature sensor in rack SNMP Varbind 3 has been set to degraded. 
(.1.3.6.1.4.1.232.0.22006)

7 Insight Management Agent: The enclosure in SNMP Varbind 5 
temperature sensor in rack SNMP Varbind 3 has been set to ok. 
(.1.3.6.1.4.1.232.0.22007)

8 Insight Management Agent: The enclosure in SNMP Varbind 5 fan in rack 
SNMP Varbind 3 has been set to failed. (.1.3.6.1.4.1.232.0.22008)

9 Insight Management Agent: The enclosure in SNMP Varbind 5 fan in rack 
SNMP Varbind 3 has been set to degraded. (.1.3.6.1.4.1.232.0.22009)

10 Insight Management Agent: The enclosure in SNMP Varbind 5 fan in rack 
SNMP Varbind 3 has been set to ok. (.1.3.6.1.4.1.232.0.22010)

11 Insight Management Agent: The enclosure in SNMP Varbind 5 fan in rack 
SNMP Varbind 3 has been removed (.1.3.6.1.4.1.232.0.22011)

12 Insight Management Agent: The enclosure in SNMP Varbind 5 fan in rack 
SNMP Varbind 3 has been inserted (.1.3.6.1.4.1.232.0.22012)

13 Insight Management Agent: The power supply in SNMP Varbind 7 in 
enclosure SNMP Varbind 5 in rack SNMP Varbind 3 has been set to 
failed. (.1.3.6.1.4.1.232.0.22013)
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14 Insight Management Agent: The power supply in SNMP Varbind 7 in 
enclosure SNMP Varbind 5 in rack SNMP Varbind 3 has been set to 
degraded. (.1.3.6.1.4.1.232.0.22014)

15 Insight Management Agent: The power supply in SNMP Varbind 7 in 
enclosure SNMP Varbind 5 in rack SNMP Varbind 3 has been set to ok. 
(.1.3.6.1.4.1.232.0.22015)

16 Insight Management Agent: The power supply in SNMP Varbind 7 in 
enclosure SNMP Varbind 5 in rack SNMP Varbind 3 has been removed 
(.1.3.6.1.4.1.232.0.22016)

17 Insight Management Agent: The power supply in SNMP Varbind 7 in 
enclosure SNMP Varbind 5 in rack SNMP Varbind 3 has been inserted 
(.1.3.6.1.4.1.232.0.22017)

18 Insight Management Agent: The power subsystem in enclosure SNMP 
Varbind 5 in rack SNMP Varbind 3 is no longer redundant 
(.1.3.6.1.4.1.232.0.22018)

19 Insight Management Agent: The rack power supply detected an input line 
voltage problem in power supply SNMP Varbind 6, enclosure in SNMP 
Varbind 5, rack in SNMP Varbind 3. (.1.3.6.1.4.1.232.0.22019)

20 Insight Management Agent: The power subsystem in enclosure SNMP 
Varbind 5 in rack SNMP Varbind 3 is in an overload condition 
(.1.3.6.1.4.1.232.0.22020)

21 Insight Management Agent: The server shutdown due to lack of power 
blade SNMP Varbind 6, in enclosure SNMP Varbind 5, in rack SNMP 
Varbind 3 (.1.3.6.1.4.1.232.0.22021)

22 Insight Management Agent: Server power on prevented to preserve 
redundancy in blade SNMP Varbind 6, in enclosure SNMP Varbind 5, in 
rack SNMP Varbind 3. (.1.3.6.1.4.1.232.0.22022)

23 Insight Management Agent: Inadequate power to power on blade SNMP 
Varbind 6, in enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22023)

24 Insight Management Agent: Inadequate power to power on blade SNMP 
Varbind 6, in enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22024)

25 Insight Management Agent: Inadequate power to power on blade SNMP 
Varbind 6, in enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22025)
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26 Insight Management Agent: Server power on via manual override on 
blade SNMP Varbind 6, in enclosure SNMP Varbind 5, in rack SNMP 
Varbind 3 (.1.3.6.1.4.1.232.0.22026)

27 Insight Management Agent: Fuse open fuse SNMP Varbind 6, in 
enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22027)

28 Insight Management Agent: Server blade in SNMP Varbind 6 removed 
from position SNMP Varbind 7, in enclosure SNMP Varbind 5, in rack 
SNMP Varbind 3 (.1.3.6.1.4.1.232.0.22028)

29 Insight Management Agent: Server blade in SNMP Varbind 6 inserted 
from position SNMP Varbind 7, in enclosure SNMP Varbind 5, in rack 
SNMP Varbind 3 (.1.3.6.1.4.1.232.0.22029)

30 Insight Management Agent: Power subsystem not load balanced in 
enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22030)

31 Insight Management Agent: Power subsystem DC power problem in 
enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22031)

32 Insight Management Agent: Power subsystem AC facility input power 
exceeded in enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22032)

33 Insight Management Agent: Unknown power consumption in rack SNMP 
Varbind 3 (.1.3.6.1.4.1.232.0.22033)

34 Insight Management Agent: Power subsystem load balancing wire 
missing for enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22034)

35 Insight Management Agent: Power subsystem has too may power 
enclosures SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22035)

36 Insight Management Agent: Power subsystem has been improperly 
configured in enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22036)

37 Insight Management Traps: The Onboard Administrator status has been 
set to degraded. (.1.3.6.1.4.1.232.0.22037)

38 Insight Management Traps: The Onboard Administrator status has been 
set to OK (.1.3.6.1.4.1.232.0.22038)
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39 Insight Management Traps: The Onboard Administrator has been 
removed (.1.3.6.1.4.1.232.0.22039)

40 Insight Management Traps: A server blade e-keying has failed and there 
is a port mapping problem between a server mezz card and the 
interconnect, in Blade SNMP Varbind 6, in position SNMP Varbind 7, in 
enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22042)

41 Insight Management Traps: Server blade e-keying has returned to normal 
operation, in Blade SNMP Varbind 6, in position SNMP Varbind 7, in 
enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22043)

42 Insight Management Traps: The interconnect has been removed from the 
enclosure, in interconnect SNMP Varbind 6, in position SNMP Varbind 7, 
in enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22044)

43 Insight Management Traps: The interconnect status has been set to 
failed, in interconnect SNMP Varbind 6, in position SNMP Varbind 7, in 
enclosure SNMP Varbind 5, in rack SNMP Varbind 3 
(.1.3.6.1.4.1.232.0.22046)
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HPSIMInt-IMAgents_FwdRecoverySvrTraps (uses 
CPQRECOV.MIB)

1 Insight Management Agent: Partner server has failed and the server 
sending the trap has taken over operations. (1.3.6.1.4.1.232.0.13001)

2 Insight Management Agent: Standby Recovery Server reports the local 
serial interconnect has failed. (1.3.6.1.4.1.232.0.13002)

3 Insight Management Agent: Recovery Server reports the standby server 
has failed. (1.3.6.1.4.1.232.0.13003)

4 Insight Management Agent: OnLine Recovery Server reports the local 
serial interconnect has failed. (1.3.6.1.4.1.232.0.13004)

5 Insight Management Agent: OnLine Recovery Server reports the failover 
attempt has failed. (1.3.6.1.4.1.232.0.13005)
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HPSIMInt-IMAgents_Fwd SANTraps

1 Insight Management Agent: Failure event detected element in SNMP 
Varbind 2 of Type SNMP Varbind 3 sent notification SNMP Varbind 4 
SNMP Varbind 5. (.1.3.6.1.4.1.232.151.11.0.1)

2 Insight Management Agent: Warning event detected element in SNMP 
Varbind 2 of Type SNMP Varbind 3 sent notification SNMP Varbind 4 
SNMP Varbind 5. (.1.3.6.1.4.1.232.151.11.0.2)

3 Insight Management Agent: Information event detected element in SNMP 
Varbind 2 of Type SNMP Varbind 3 sent notification SNMP Varbind 4 
SNMP Varbind 5. (.1.3.6.1.4.1.232.151.11.0.4)
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HPSIMInt-IMAgents_FwdSCSIDevicesTraps (uses 
CPQSCSI.MIB)

1 Insight Management Agent: Status of a SCSI Controller is NORMAL. 
(1.3.6.1.4.1.232.5.0.1)

2 Insight Management Agent: Status of a SCSI Controller is FAILED. 
(1.3.6.1.4.1.232.5.0.1)

3 Insight Management Agent: Status of a SCSI Logical Drive is NORMAL 
(1.3.6.1.4.1.232.5.0.2)

4 Insight Management Agent: Status of a SCSI Logical Drive is FAILED 
(1.3.6.1.4.1.232.5.0.2)

5 Insight Management Agent: Status of a SCSI Logical Drive is 
RECOVERING (1.3.6.1.4.1.232.5.0.2)

6 Insight Management Agent: A wrong SCSI Logical Drive has been 
REPLACED (1.3.6.1.4.1.232.5.0.2)

7 Insight Management Agent: Status of a SCSI Logical Drive is 
BADCONNECT (1.3.6.1.4.1.232.5.0.2)

8 Insight Management Agent: Status of a SCSI Logical Drive is 
DEGRADED (1.3.6.1.4.1.232.5.0.2)

9 Insight Management Agent: Status of a SCSI physical drive is NORMAL 
(1.3.6.1.4.1.232.5.0.3)

10 Insight Management Agent: Status of a SCSI physical drive is FAILED 
(1.3.6.1.4.1.232.5.0.3)

11 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS OK (1.3.6.1.4.1.232.5.0.3)

12 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS FAILED (1.3.6.1.4.1.232.5.0.3)

13 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS OFFLINE (1.3.6.1.4.1.232.5.0.3)

14 Insight Management Agent: Status of a SCSI physical drive is 
BADCABLE (1.3.6.1.4.1.232.5.0.3)

15 Insight Management Agent: Status of a SCSI physical drive is 
PREDICTIVE FAILURE (1.3.6.1.4.1.232.5.0.3)
154 Appendix B



16 Insight Management Agent: Status of a SCSI physical drive is OFFLNE 
(1.3.6.1.4.1.232.5.0.3)

17 Insight Management Agent: SCSI Controller Status is NORMAL. 
(1.3.6.1.4.1.232.0.5001)

18 Insight Management Agent: SCSI Controller Status is FAILED. 
(1.3.6.1.4.1.232.0.5001)

19 Insight Management Agent: Status of a SCSI Logical Drive is NORMAL 
(1.3.6.1.4.1.232.0.5002)

20 Insight Management Agent: Status of a SCSI Logical Drive is FAILED 
(1.3.6.1.4.1.232.0.5002)

21 Insight Management Agent: Status of a SCSI Logical Drive is 
RECOVERING (1.3.6.1.4.1.232.0.5002)

22 Insight Management Agent: A wrong SCSI Logical Drive has been 
REPLACED (1.3.6.1.4.1.232.0.5002)

23 Insight Management Agent: Status of a SCSI Logical Drive is 
BADCONNECT (1.3.6.1.4.1.232.0.5002)

24 Insight Management Agent: Status of a SCSI physical drive is NORMAL 
(1.3.6.1.4.1.232.0.5003)

25 Insight Management Agent: Status of a SCSI physical drive is FAILED 
(1.3.6.1.4.1.232.0.5003)

26 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS OK (1.3.6.1.4.1.232.0.5003)

27 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS FAILED (1.3.6.1.4.1.232.0.5003)

28 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS OFFLINE (1.3.6.1.4.1.232.0.5003)

29 Insight Management Agent: Status of a SCSI physical drive is 
BADCABLE (1.3.6.1.4.1.232.0.5003)

30 Insight Management Agent: Status of a SCSI physical drive is 
PREDICTIVE FAILURE (1.3.6.1.4.1.232.0.5003)

31 Insight Management Agent: Status of a SCSI physical drive is OFFLNE 
(1.3.6.1.4.1.232.0.5003)

32 Insight Management Agent: Status of SCSI Tape Drive is NORMAL 
(1.3.6.1.4.1.232.0.5004)
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33 Insight Management Agent: Status of SCSI Tape Drive is DEGRADED 
(1.3.6.1.4.1.232.0.5004)

34 Insight Management Agent: Status of SCSI Tape Drive is FAILED 
(1.3.6.1.4.1.232.0.5004)

35 Insight Management Agent: SCSI Controller Status is NORMAL. 
(1.3.6.1.4.1.232.0.5005)

36 Insight Management Agent: SCSI Controller Status is FAILED. 
(1.3.6.1.4.1.232.0.5005)

37 Insight Management Agent: Status of a SCSI physical drive is NORMAL 
(1.3.6.1.4.1.232.0.5006)

38 Insight Management Agent: Status of a SCSI physical drive is FAILED 
(1.3.6.1.4.1.232.0.5006)

39 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS OK (1.3.6.1.4.1.232.0.5006)

40 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS FAILED (1.3.6.1.4.1.232.0.5006)

41 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS OFFLINE (1.3.6.1.4.1.232.0.5006)

42 Insight Management Agent: Status of a SCSI physical drive is 
BADCABLE (1.3.6.1.4.1.232.0.5006)

43 Insight Management Agent: Status of a SCSI physical drive is 
PREDICTIVE FAILURE (1.3.6.1.4.1.232.0.5006)

44 Insight Management Agent: Status of a SCSI physical drive is OFFLNE 
(1.3.6.1.4.1.232.0.5006)

45  Insight Management Agent: Status of SCSI Tape Drive is NORMAL 
(1.3.6.1.4.1.232.0.5007)

46 Insight Management Agent: Status of SCSI Tape Drive is DEGRADED 
(1.3.6.1.4.1.232.0.5007)

47 Insight Management Agent: Status of SCSI Tape Drive is FAILED 
(1.3.6.1.4.1.232.0.5007)

48 Insight Management Agent: A SCSI Tape Drive requires cleaning 
(1.3.6.1.4.1.232.0.5008)

49 Insight Management Agent: Cleaning tape used on an attached tape drive 
needs to be replaced. (1.3.6.1.4.1.232.0.5009)
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50 Insight Management Agent: A Tape Library is not 
operational(1.3.6.1.4.1.232.0.5010)

51 Insight Management Agent: Tape library error has been resolved. 
(1.3.6.1.4.1.232.0.5011)

52 Insight Management Agent: Tape Library status has degraded 
(1.3.6.1.4.1.232.0.5012)

53 Insight Management Agent: Tape Library door was left open. 
(1.3.6.1.4.1.232.0.5013)

54  Insight Management Agent: Tape Library door is now closed. 
(1.3.6.1.4.1.232.0.5014)

55 Insight Management Agent: DVD library status is OK. 
(1.3.6.1.4.1.232.0.5015)

56 Insight Management Agent: DVD library status is DEGRADED. 
(1.3.6.1.4.1.232.0.5015)

57 Insight Management Agent: DVD library status is FAILED. 
(1.3.6.1.4.1.232.0.5015)

58 Insight Management Agent: Status of SCSI Tape Physical Drive is 
NORMAL (1.3.6.1.4.1.232.0.5016)

59 Insight Management Agent: Status of SCSI Tape Physical Drive is 
FAILED (1.3.6.1.4.1.232.0.5016)

60 Insight Management Agent: Status of SCSI Tape Physical Drive is 
OFFLINE (1.3.6.1.4.1.232.0.5016)

61 Insight Management Agent: Status of SCSI Tape Physical Drive is 
MISSING WAS OK (1.3.6.1.4.1.232.0.5016)

62 Insight Management Agent: Status of SCSI Tape Physical Drive is 
MISSING WAS FAILED (1.3.6.1.4.1.232.0.5016)

63 Insight Management Agent: Status of SCSI Tape Physical Drive is 
MISSING WAS OFFLINE (1.3.6.1.4.1.232.0.5016)

64 Insight Management Agent: Status of a SCSI physical drive is NORMAL 
(1.3.6.1.4.1.232.0.5017)

65 Insight Management Agent: Status of a SCSI physical drive is FAILED 
(1.3.6.1.4.1.232.0.5017)

66 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS OK (1.3.6.1.4.1.232.0.5017)
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67 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS FAILED (1.3.6.1.4.1.232.0.5017)

68 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS OFFLINE (1.3.6.1.4.1.232.0.5017)

69 Insight Management Agent: Status of a SCSI physical drive is 
BADCABLE (1.3.6.1.4.1.232.0.5017)

70 Insight Management Agent: Status of a SCSI physical drive is 
PREDICTIVE FAILURE (1.3.6.1.4.1.232.0.5017)

71 Insight Management Agent: Status of a SCSI physical drive is OFFLNE 
(1.3.6.1.4.1.232.0.5017)

72 Insight Management Agent: Status of SCSI Tape Library is NORMAL 
(1.3.6.1.4.1.232.0.5018)

73 Insight Management Agent: Status of SCSI Tape Library is DEGRADED 
(1.3.6.1.4.1.232.0.5018)

74 Insight Management Agent: Status of SCSI Tape Library is FAILED 
(1.3.6.1.4.1.232.0.5018)

75 Insight Management Agent: Status of SCSI Tape Library is OFFLINE 
(1.3.6.1.4.1.232.0.5018)

76 Insight Management Agent: Status of SCSI Tape Physical Drive is 
NORMAL (1.3.6.1.4.1.232.0.5019)

77 Insight Management Agent: Status of SCSI Tape Physical Drive is 
FAILED (1.3.6.1.4.1.232.0.5019)

78 Insight Management Agent: Status of SCSI Tape Physical Drive is 
OFFLINE (1.3.6.1.4.1.232.0.5019)

79 Insight Management Agent: Status of SCSI Tape Physical Drive is 
MISSING WAS OK (1.3.6.1.4.1.232.0.5019)

80 Insight Management Agent: Status of SCSI Tape Physical Drive is 
MISSING WAS FAILED (1.3.6.1.4.1.232.0.5019)

81 Insight Management Agent: Status of SCSI Tape Physical Drive is 
MISSING WAS OFFLINE(1.3.6.1.4.1.232.0.5019)

82 Insight Management Agent: Status of a SCSI physical drive is NORMAL 
(1.3.6.1.4.1.232.0.5020)

83 Insight Management Agent: Status of a SCSI physical drive is FAILED 
(1.3.6.1.4.1.232.0.5020)
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84  Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS OK (1.3.6.1.4.1.232.0.5020)

85 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS FAILED (1.3.6.1.4.1.232.0.5020)

86 Insight Management Agent: Status of a SCSI physical drive is MISSING 
WAS OFFLINE (1.3.6.1.4.1.232.0.5020)

87 Insight Management Agent: Status of a SCSI physical drive is 
BADCABLE (1.3.6.1.4.1.232.0.5020)

88 Insight Management Agent: Status of a SCSI physical drive is 
PREDICTIVE FAILURE (1.3.6.1.4.1.232.0.5020)

89 Insight Management Agent: Status of a SCSI physical drive is OFFLNE 
(1.3.6.1.4.1.232.0.5020)

90 Insight Management Agent: Status of SCSI logical drive is NORMAL 
(1.3.6.1.4.1.232.0.5021)

91 Insight Management Agent: Status of SCSI logical drive is FAILED 
(1.3.6.1.4.1.232.0.5021)

92 Insight Management Agent: Status of SCSI logical drive is 
UNCONFIGURED (1.3.6.1.4.1.232.0.5021)

93 Insight Management Agent: Status of SCSI logical drive is RECOVERING 
(1.3.6.1.4.1.232.0.5021)

94 Insight Management Agent: Status of SCSI logical drive is 
READYREBUILD (1.3.6.1.4.1.232.0.5021)

95 Insight Management Agent: Status of SCSI logical drive is REBUILDING 
(1.3.6.1.4.1.232.0.5021)

96 Insight Management Agent: Status of SCSI logical drive is 
WRONGDRIVE (1.3.6.1.4.1.232.0.5021)

97 Insight Management Agent: Status of SCSI logical drive is 
BADCONNECT (1.3.6.1.4.1.232.0.5021)

98 Insight Management Agent: Status of SCSI logical drive is DEGRADED 
(1.3.6.1.4.1.232.0.5021)

99 Insight Management Agent: Status of SCSI logical drive is DISABLED 
(1.3.6.1.4.1.232.0.5021)

100 Insight Management Traps: Status of SCSI logical drive is DEGRADED 
(1.3.6.1.4.1.232.0.5021)
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101 Insight Management Traps: Physical Drive Status has changed 
(1.3.6.1.4.1.232.0.5022)

102 Insight Management Traps: Logical Drive Status has changed 
(1.3.6.1.4.1.232.0.5023)

103 Insight Management Traps: SAS Tape Drive Status has changed 
(1.3.6.1.4.1.232.0.5025)
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HPSIMInt-IMAgents_FwdSysInfoTraps (uses 
CPQSINFO.MIB)

1 Insight Management Agent: Hood is removed from unit. 
(1.3.6.1.4.1.232.0.2001)

2 Insight Management Agent: The monitor condition has been set to OK. 
(1.3.6.1.4.1.232.0.2002)

3 Insight Management Agent: The monitor condition has been set to 
degraded. (1.3.6.1.4.1.232.0.2003)

4 Insight Management Agent: The monitor condition has been set to failed. 
(1.3.6.1.4.1.232.0.2004)

5 Insight Management Agent: The Memory Module ECC status has been set 
to degraded. (1.3.6.1.4.1.232.0.2005)

6 Insight Management Agent: The Memory Module ECC status has been set 
to OK. (1.3.6.1.4.1.232.0.2006)

7 Insight Management Agent: The system’s memory configuration has 
changed. (1.3.6.1.4.1.232.0.2007)

8 Insight Management Agent: Hot Plug Slot Board Removed from Chassis. 
(1.3.6.1.4.1.232.0.2008)

9 Insight Management Agent: Hot Plug Slot Board Inserted into Chassis 
contained in SNMP Varbind 3, Slot contained in SNMP Varbind 4. 
(1.3.6.1.4.1.232.0.2009)

10 Insight Management Agent: Hot Plug Slot Board Failed in Chassis 
contained in SNMP Varbind 3, Slot contained in SNMP Varbind 4, Error 
contained in SNMP ind 5. (1.3.6.1.4.1.232.0.2010)

11 Insight Management Agent: Battery contained in SNMP Varbind 3 has 
failed. (1.3.6.1.4.1.232.0.2011)

12 Insight Management Agent: Battery contained in SNMP Varbind 3 has 
degraded charging capacity. (1.3.6.1.4.1.232.0.2012)

13 Insight Management Agent: Battery contained in SNMP Varbind 3 has 
calibration error. (1.3.6.1.4.1.232.0.2013)
SNMP Trap Interceptor Policies 161



HPSIMInt-IMAgents_FwdServerMgrTraps (uses 
CPQSRVMN.MIB)

1 Insight Management Agent: Server Manager/R board failure detected. 
(1.3.6.1.4.1.232.4.0.1)

2 Insight Management Agent: Server Manager/R board has been reset. 
(1.3.6.1.4.1.232.4.0.2)

3 Insight Management Agent: Threshold exceeded on Server Manager 
monitored item. (1.3.6.1.4.1.232.4.0.3)

4 Insight Management Agent: Asynchronous communication failure on 
Server Manager Board. (1.3.6.1.4.1.232.4.0.4)

5 Insight Management Agent: Server Manager/R battery has failed. 
(1.3.6.1.4.1.232.4.0.5)

6 Insight Management Agent: Server Manager/R board is not responding. 
(1.3.6.1.4.1.232.4.0.6)

7 Insight Management Agent: Phone number, Pager ID blacklisted. The 
Phone number is contained in SNMP Varbind 2, Pager ID is contained in 
SNMP Varbind 3 (1.3.6.1.4.1.232.4.0.7)
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HPSIMInt-IMAgents_FwdPCConfigTraps (uses 
CPQSTDEQ.MIB)

1 Insight Management Agent: CPU internal corrected errors have passed a 
set threshold. (1.3.6.1.4.1.232.0.1001)

2 Insight Management Agent: Safe PC Card Thermal operating conditions 
exceeded. (1.3.6.1.4.1.232.0.1002)

3 Insight Management Agent: Degraded PC Card Thermal operating 
conditions exceeded. (1.3.6.1.4.1.232.0.1003)

4 Insight Management Agent: Degraded/Failed PC Card Thermal 
conditions restored to Safe operations. (1.3.6.1.4.1.232.0.1004)

5 Insight Management Agent: CPU internal corrected errors have passed a 
set threshold. (1.3.6.1.4.1.232.0.1005)

6 Insight Management Traps: Status change of Processor in Slot 
(1.3.6.1.4.1.232.0.1006)

7 Insight Management Traps: Power supply status change of Processor in 
Slot (1.3.6.1.4.1.232.0.1007)

8 Insight Management Traps: A USB storage device has been attached to 
the system.(1.3.6.1.4.1.232.0.1008)
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HPSIMInt-IMAgents_FwdStorageSysTraps (uses 
CPQSTSYS.MIB)

1 Insight Management Agent: Storage System fan status changed to OK, 
status contained in SNMP Varbind 1. (1.3.6.1.4.1.232.0.8001)

2 Insight Management Agent: Storage System fan status changed to 
FAILED, status contained in SNMP Varbind 1. (1.3.6.1.4.1.232.0.8001)

3 Insight Management Agent: Storage System fan status changed to 
DEGRADED, status contained in SNMP Varbind 1. 
(1.3.6.1.4.1.232.0.8001)

4 Insight Management Agent: This unit does not support fan monitoring, 
status contained in SNMP Varbind1 (.1.3.6.1.4.1.232.0.8001)

5 Insight Management Agent: Storage System will be shutdown because of 
temperature failure. (1.3.6.1.4.1.232.0.8002)

6 Insight Management Agent: Storage System temperature degraded 
(1.3.6.1.4.1.232.0.8003)

7 Insight Management Agent: Storage System temperature OK. 
(1.3.6.1.4.1.232.0.8004)

8 Insight Management Agent: Storage System side panel is reinstalled on 
unit. (1.3.6.1.4.1.232.0.8005)

9 Insight Management Agent: Storage System side panel is removed from 
unit. (1.3.6.1.4.1.232.0.8006)

10 Insight Management Agent: Storage System power supply unit has 
become degraded (1.3.6.1.4.1.232.0.8007)

11 Insight Management Agent: Storage System fan status changed to OK, 
status is contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.8008)

12 Insight Management Agent: Storage System fan status changed to Failed, 
status is contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.8008)

13 Insight Management Agent: Storage System fan status changed to 
Degraded, status is contained in SNMP Varbind 3. (1.3.6.1.4.1.232.0.8008)

14 Insight Management Agent: Storage System will be shutdown. 
(1.3.6.1.4.1.232.0.8009)
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15 Insight Management Agent: Storage System temperature degraded. 
(1.3.6.1.4.1.232.0.8010)

16 Insight Management Agent: Storage System temperature OK. 
(1.3.6.1.4.1.232.0.8011)

17 Insight Management Agent: Storage System side panel is reinstalled on 
unit. (1.3.6.1.4.1.232.0.8012)

18 Insight Management Agent: Storage System side panel is removed from 
unit. (1.3.6.1.4.1.232.0.8013)

19 Insight Management Agent: Storage System power supply unit has 
become degraded (1.3.6.1.4.1.232.0.8014)

20 Insight Management Agent: Storage System power supply unit has 
become degraded (1.3.6.1.4.1.232.0.8015)

21 Insight Management Agent: Storage System fan status changed to OK, 
status is contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.8016)

22 Insight Management Agent: Storage System fan status changed to 
Degraded, status is contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.8016)

23 Insight Management Agent: Storage System fan status changed to Failed, 
status is contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.8016)

24 Insight Management Agent: Storage System power supply status changed 
to OK, status is contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.8017)

25 Insight Management Agent: Storage System power supply status changed 
to Failed, status is contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.8017)

26 Insight Management Agent: Storage System power supply status changed 
to Degraded, status is contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.8017)

27 Insight Management Agent: Storage System power supply UPS status 
changed to OK, status is contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.8018)

28 Insight Management Agent: Storage System power supply UPS status 
changed to Power failed, status is contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.8018)

29 Insight Management Agent: Storage System power supply UPS status 
changed to Battery low, status is contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.8018)
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30 Insight Management Agent: Storage System temperature sensor status 
has changed to OK, status is contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.8019)

31 Insight Management Agent: Storage System temperature sensor status 
has changed to Degraded, status is contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.8019)

32 Insight Management Agent: Storage System temperature sensor status 
has changed to Failed, status is contained in SNMP Varbind 6. 
(1.3.6.1.4.1.232.0.8019)

33 Insight Management Agent: Storage System fan status changed to OK, 
status is contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.8020)

34 Insight Management Agent: Storage System fan status changed to 
Degraded, status is contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.8020)

35  Insight Management Agent: Storage System fan status changed to 
Failed, states is contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.8020)

36 Insight Management Agent: Storage System power supply status changed 
to OK, status is contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.8021)

37 Insight Management Agent: Storage System power supply status changed 
to Failed, status is contained in SNMP Varbind 6. (1.3.6.1.4.1.232.0.8021)

38 Insight Management Agent: Storage System fan status changed to OK, 
status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8022)

39 Insight Management Agent: Storage System fan status changed to 
Degraded, status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8022)

40 Insight Management Agent: Storage System fan status changed to Failed, 
status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8022)

41 Insight Management Agent: Storage System temperature status changed 
to OK, status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8023)

42 Insight Management Agent: Storage System temperature status changed 
to Degraded, status is contained in SNMP Varbind 9. 
(1.3.6.1.4.1.232.0.8023)

43 Insight Management Agent: Storage System temperature status changed 
to Failed, status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8023)

44 Insight Management Agent: Storage System power supply status changed 
to OK, status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8024)
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45 Insight Management Agent: Storage System power supply status changed 
to Degraded, status is contained in SNMP Varbind 9. 
(1.3.6.1.4.1.232.0.8024)

46 Insight Management Agent: Storage System power supply status changed 
to Failed, status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8024)

47 Insight Management Agent: Storage System fan status changed to OK, 
status is contained in SNMP Varbind 1. (1.3.6.1.4.1.232.8.0.1)

48 Insight Management Agent: Storage System fan status changed to Failed, 
status is contained in SNMP Varbind 1. (1.3.6.1.4.1.232.8.0.1)

49 Insight Management Agent: Storage System fan status changed to 
Degraded, status is contained in SNMP Varbind 1. (1.3.6.1.4.1.232.8.0.1)

50 Insight Management Agent: Storage system recovery server option status 
changed to DEAMON DOWN DISABLED, status is contained in SNMP 
Varbind 5. (1.3.6.1.4.1.232.0.8025)

51 Insight Management Agent: Storage system recovery server option status 
changed to OK, status is contained in SNMP Varbind 5. 
(1.3.6.1.4.1.232.0.8025)

52 Insight Management Agent: Storage system recovery server option status 
changed to DEAMON DOWN ACTIVE, status is contained in SNMP 
Varbind 5. (1.3.6.1.4.1.232.0.8025)

53 Insight Management Agent: Storage system recovery server option status 
changed to NOSECONDARY, status is contained in SNMP Varbind 5. 
(1.3.6.1.4.1.232.0.8025)

54 Insight Management Agent: Storage system recovery server option status 
changed to DEAMON DOWN NOSECONDARY, status is contained in 
SNMP Varbind 5. (1.3.6.1.4.1.232.0.8025)

55 Insight Management Agent: Storage system recovery server option status 
changed to LINKDOWN, status is contained in SNMP Varbind 5. 
(1.3.6.1.4.1.232.0.8025)

56 Insight Management Agent: Storage system recovery server option status 
changed to DEAMON DOWN LINKDOWN, status is contained in SNMP 
Varbind 5. (1.3.6.1.4.1.232.0.8025)

57 Insight Management Agent: Storage system recovery server option status 
changed to SECONDARY RUNNING AUTO, status is contained in SNMP 
Varbind 5. (1.3.6.1.4.1.232.0.8025)
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58 Insight Management Agent: Storage system recovery server option status 
changed to SECONDARY RUNNING USER, status is contained in SNMP 
Varbind 5. (1.3.6.1.4.1.232.0.8025)

59 Insight Management Agent: Storage System fan status changed to OK, 
status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8026)

60 Insight Management Agent: Storage System fan status changed to Failed, 
status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8026)

61 Insight Management Agent: Storage System fan status changed to 
Degraded, status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8026)

62 Insight Management Agent: Storage System temperature status is 
degraded, status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8027)

63 Insight Management Agent: Storage System temperature status is failed, 
status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8027)

64 Insight Management Agent: Storage System temperature status is ok, 
status is contained in SNMP Varbind 9. (1.3.6.1.4.1.232.0.8027)

65 Insight Management Agent: Storage System power supply unit status is 
degraded, status is contained in SNMP Varbind 9 (1.3.6.1.4.1.232.0.8028)

66 Insight Management Agent: Storage System power supply unit status is 
failed, status is contained in SNMP Varbind 9 (1.3.6.1.4.1.232.0.8028)

67 Insight Management Agent: Storage System power supply unit status is 
OK, status contained in SNMP Varbind 9 (1.3.6.1.4.1.232.0.8028)

68 Insight Management Traps: Storage System fan status has changed, 
status contained in SNMP Varbind 9 (1.3.6.1.4.1.232.0.8029)

69 Insight Management Traps: Storage System temperature status has 
changed, status contained in SNMP Varbind 9 (1.3.6.1.4.1.232.0.8030)

70 Insight Management Traps: Storage system power supply status has 
changed, status is contained in SNMP Varbind 9 (1.3.6.1.4.1.232.0.8031)
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HPSIMInt-IMAgents_FwdSWCCTraps (uses 
CPQSWCC.MIB)

1 Insight Management Agent: Fiber channel device status is OK, status is 
now contained in SNMP Varbind 3. (.1.3.6.1.4.1.232.132.2.0.1)

2 Insight Management Agent: Fiber channel device status is Degraded, 
status is now contained in SNMP Varbind 3. (.1.3.6.1.4.1.232.132.2.0.1)

3 Insight Management Agent: Fiber channel device status is FAILED, 
status is now contained in SNMP Varbind 3. (.1.3.6.1.4.1.232.132.2.0.1)

4 Insight Management Agent: Fiber channel tape controller device status is 
OK, status is now contained in SNMP Varbind 3. 
(.1.3.6.1.4.1.232.132.2.0.2)

5 Insight Management Agent: Fiber channel tape controller device status is 
DEGRADED, status is now contained in SNMP Varbind 3. 
(.1.3.6.1.4.1.232.132.2.0.2)

6 Insight Management Agent: Fiber channel tape controller device status is 
FAILED, status is now contained in SNMP Varbind 3. 
(.1.3.6.1.4.1.232.132.2.0.2)

7 Insight Management Agent: EMU/Device Manager device status is OK, 
status is now contained in SNMP Varbind 3. (.1.3.6.1.4.1.232.132.3.0.1)

8 Insight Management Agent: EMU/Device Manager device status is 
DEGRADED, status is now contained in SNMP Varbind 3. 
(.1.3.6.1.4.1.232.132.3.0.1)

9 Insight Management Agent: EMU/Device Manager device status is 
FAILED, status is now contained in SNMP Varbind 3. 
(.1.3.6.1.4.1.232.132.3.0.1)

10 Insight Management Agent: Some event has happened to a physical 
device on a KZPCC controller (.1.3.6.1.4.1.232.132.4.1.0.1)

11 Insight Management Agent: Some event has happened to a virtual device 
(logical drive) on a KZPCC controller (.1.3.6.1.4.1.232.132.4.1.0.2)

12 Insight Management Agent: Some event has happened to a KZPCC 
controller (.1.3.6.1.4.1.232.132.4.1.0.3)
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HPSIMInt-IMAgents_FwdThresholdMgmtTraps (uses 
CPQTHRSH.MIB)

1 Insight Management Agent: Rising threshold passed 
(1.3.6.1.4.1.232.0.10001)

2 Insight Management Agent: Falling threshold passed. 
(1.3.6.1.4.1.232.0.10002)

3 Insight Management Agent: Rising threshold passed 
(1.3.6.1.4.1.232.0.10003)

4 Insight Management Agent: Falling threshold passed 
(1.3.6.1.4.1.232.0.10004)

5 Insight Management Agent: Rising threshold passed 
(1.3.6.1.4.1.232.0.10005)

6 Insight Management Agent: Falling threshold passed 
(1.3.6.1.4.1.232.0.10006)

7 Insight Management Agent: Critical Rising Threshold Crossed 
(1.3.6.1.4.1.232.0.10007)

8 Insight Management Traps: Critical Falling Threshold Crossed 
(1.3.6.1.4.1.232.0.10008)
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HPSIMInt-IMAgents_FwdUPSTraps (uses CPQUPS.MIB)

1 Insight Management Agent: UPS reports AC line power failure. 
(1.3.6.1.4.1.232.0.12001)

2 Insight Management Agent: UPS reports AC line power has returned. 
(1.3.6.1.4.1.232.0.12002)

3 Insight Management Agent: UPS has initiated server shutdown. 
(1.3.6.1.4.1.232.0.12003)

4 Insight Management Agent: Server now operational after UPS shutdown. 
(1.3.6.1.4.1.232.0.12004)

5 Insight Management Agent: UPS battery low server will soon lose power. 
(1.3.6.1.4.1.232.0.12005)

6 Insight Management Agent: UPS reports AC line power failure. 
(1.3.6.1.4.1.232.0.12006)

7 Insight Management Agent: UPS reports AC line power has returned. 
(1.3.6.1.4.1.232.0.12007)

8 Insight Management Agent: UPS has initiated server shutdown. 
(1.3.6.1.4.1.232.0.12008)

9 Insight Management Agent: Server now operational after UPS shutdown. 
(1.3.6.1.4.1.232.0.12009)

10 Insight Management Agent: UPS battery is low server will soon lose 
power. (1.3.6.1.4.1.232.0.12010)

11 Insight Management Agent: UPS has been overloaded. 
(1.3.6.1.4.1.232.0.12011)

12 Insight Management Agent: UPS battery is about to fail. 
(1.3.6.1.4.1.232.0.12012)

13 Insight Management Agent: UPS critical alarm received 
(1.3.6.1.4.1.232.0.12013)

14 Insight Management Agent: UPS informational alarm received 
(1.3.6.1.4.1.232.0.12014)
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HPSIMInt-IMAgents_FwdSTEAMTraps (uses 
HS_agent.mib)

1 Insight Management Agent: Disk device has failed 
(.1.3.6.1.4.1.36.2.15.21.0.1)

2 Insight Management Agent: Disk device has recovered 
(1.3.6.1.4.1.36.2.15.21.0.2)

3 Insight Management Agent: Power supply has failed 
(.1.3.6.1.4.1.36.2.15.21.0.3)

4 Insight Management Agent: Power supply device has recovered 
(.1.3.6.1.4.1.36.2.15.21.0.4)

5 Insight Management Agent: Fan has failed (.1.3.6.1.4.1.36.2.15.21.0.5)

6 Insight Management Agent: Fan has recovered (.1.3.6.1.4.1.36.2.15.21.0.6)

7 Insight Management Agent: Cache Battery has failed 
(.1.3.6.1.4.1.36.2.15.21.0.7)

8 Insight Management Agent: Cache Battery has LOW state 
(.1.3.6.1.4.1.36.2.15.21.0.8)

9 Insight Management Agent: Cache Battery has good state 
(.1.3.6.1.4.1.36.2.15.21.0.9)

10 Insight Management Agent: Temperature Sensor has exceeded 
WARNING threshold limit (1.3.6.1.4.1.36.2.15.21.0.10)

11 Insight Management Agent: Temperature Sensor has dropped below 
WARNING threshold limit (1.3.6.1.4.1.36.2.15.21.0.11)

12 Insight Management Agent: Agent on host has lost communication with 
subsystem (1.3.6.1.4.1.36.2.15.21.0.12)

13 Insight Management Agent: Agent on host has recovered communication 
with subsystem (1.3.6.1.4.1.36.2.15.21.0.13)

14 Insight Management Agent: The Secondary Controller has failed 
(1.3.6.1.4.1.36.2.15.21.0.14)

15 Insight Management Agent: The Secondary Controller has recovered 
(.1.3.6.1.4.1.36.2.15.21.0.15)

16 Insight Management Agent: LUN has failed (1.3.6.1.4.1.36.2.15.21.0.16)
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17 Insight Management Agent: LUN is now in reconstruct mode 
(1.3.6.1.4.1.36.2.15.21.0.17)

18 Insight Management Agent: LUN is in degraded 
state(1.3.6.1.4.1.36.2.15.21.0.18)

19 Insight Management Agent: LUN is in optimal state 
(1.3.6.1.4.1.36.2.15.21.0.19)

20 Insight Management Agent: The External Input to the EMU in cabinet 
indicates a failure (1.3.6.1.4.1.36.2.15.21.0.20)

21 Insight Management Agent: The External Input to the EMU in cabinet 
indicates a recovery (1.3.6.1.4.1.36.2.15.21.0.21)

22 Insight Management Agent: Cache Battery has unknown state 
(.1.3.6.1.4.1.36.2.15.21.0.22)
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HPSIMInt-IMAgents_FwdRPMTraps (uses 
CPQRPM.MIB)

1 Insight Management Agent: A UPS device is reporting a Connection Lost 
(1.3.6.1.4.1.232.154.2.1)

2 Insight Management Agent: A UPS device is reporting a Connection Lost 
(1.3.6.1.4.1.232.154.2.2)

3 Insight Management Agent: A CMC device is reporting temperature 1 
below minimum threshold (1.3.6.1.4.1.232.154.2.10001)

4 Insight Management Agent: A CMC device is reporting temperature 1 
above warning threshold (1.3.6.1.4.1.232.154.2.10002)

5 Insight Management Agent: A CMC device is reporting temperature 1 
above warning threshold (1.3.6.1.4.1.232.154.2.10002)

6 Insight Management Agent: A CMC device is reporting temperature 1 
above maximum threshold (1.3.6.1.4.1.232.154.2.10003)

7 Insight Management Agent: A CMC device is reporting temperature 1 has 
returned to a normal (1.3.6.1.4.1.232.154.2.10004)

8 Insight Management Agent: A CMC device is reporting temperature 2 
below minimum threshold (1.3.6.1.4.1.232.154.2.10005)

9 Insight Management Agent: A CMC device is reporting temperature 2 
above warning threshold (1.3.6.1.4.1.232.154.2.10006)

10 Insight Management Agent: A CMC device is reporting temperature 2 
above maximum threshold (1.3.6.1.4.1.232.154.2.10007)

11 Insight Management Agent: A CMC device is reporting temperature 2 has 
returned to a normal temperature (1.3.6.1.4.1.232.154.2.10008)

12 Insight Management Agent: A CMC device is reporting voltage below 
minimum threshold (1.3.6.1.4.1.232.154.2.10011)

13 Insight Management Agent: A CMC device is reporting voltage above 
maximum threshold (1.3.6.1.4.1.232.154.2.10012)

14 Insight Management Agent: A CMC device is reporting voltage has 
returned to normal (1.3.6.1.4.1.232.154.2.10013)

15 Insight Management Agent: A CMC device is reporting humidity below 
minimum threshold (1.3.6.1.4.1.232.154.2.10021)
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16 Insight Management Agent: A CMC device is reporting humidity above 
maximum threshold (1.3.6.1.4.1.232.154.2.10022)

17 Insight Management Agent: A CMC device is reporting humidity has 
returned to normal (1.3.6.1.4.1.232.154.2.10023)

18 Insight Management Agent: A CMC device is reporting smoke detected 
(1.3.6.1.4.1.232.154.2.10031)

19 Insight Manager: A CMC device is reporting smoke cleared 
(1.3.6.1.4.1.232.154.2.10032)

20 Insight Management Agent: A CMC device is reporting shock detected 
(1.3.6.1.4.1.232.154.2.10041)

21 Insight Management Agent: A CMC device is reporting shock cleared 
(1.3.6.1.4.1.232.154.2.10042)

22 Insight Management Agent: A CMC device has entered an alarm 
condition for auxiliary input 1(1.3.6.1.4.1.232.154.2.10051)

23 Insight Management Agent: A CMC device is reporting auxiliary input 1 
alarm cleared (1.3.6.1.4.1.232.154.2.10052)

24 Insight Management Agent: A CMC device has entered an alarm 
condition for auxiliary input 2(1.3.6.1.4.1.232.154.2.10053)

25 Insight Management Agent: A CMC device is reporting auxiliary input 2 
alarm cleared (1.3.6.1.4.1.232.154.2.10054)

26 Insight Management Agent: A CMC device is reporting input 1 has been 
opened (1.3.6.1.4.1.232.154.2.10101)

27 Insight Management Agent: A CMC device is reporting input 1 has been 
closed (1.3.6.1.4.1.232.154.2.10102)

28 Insight Management Agent: A CMC device is reporting input 2 has been 
opened (1.3.6.1.4.1.232.154.2.10103)

29 Insight Management Agent: A CMC device is reporting input 2 has been 
closed (1.3.6.1.4.1.232.154.2.10104)

30 Insight Management Agent: A CMC device is reporting input 3 has been 
opened (1.3.6.1.4.1.232.154.2.10105)

31 Insight Management Agent: A CMC device is reporting input 3 has been 
closed (1.3.6.1.4.1.232.154.2.10106)

32 Insight Management Agent: A CMC device is reporting input 4 has been 
opened (1.3.6.1.4.1.232.154.2.10107)
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33 Insight Management Agent: A CMC device is reporting input 4 has been 
closed (1.3.6.1.4.1.232.154.2.10108)

34 Insight Management Agent: A CMC device is reporting lockset 1 has been 
unlocked (1.3.6.1.4.1.232.154.2.10111)

35 Insight Management Agent: A CMC device is reporting lockset 1 has 
failed to lock (1.3.6.1.4.1.232.154.2.10112)

36 Insight Management Agent: A CMC device is reporting an error with 
lockset 1(1.3.6.1.4.1.232.154.2.10113)

37 Insight Management Agent: A CMC device is reporting lockset 1 has been 
locked (1.3.6.1.4.1.232.154.2.10114)

38 Insight Management Agent: A CMC device is reporting lockset 2 has been 
unlocked (1.3.6.1.4.1.232.154.2.10116)

39 Insight Management Agent: A CMC device is reporting lockset 2 has 
failed to lock (1.3.6.1.4.1.232.154.2.10117)

40 Insight Management Agent: A CMC device is reporting an error with 
lockset 2 (1.3.6.1.4.1.232.154.2.10118)

41 Insight Management Agent: A CMC device is reporting lockset 2 has been 
locked (1.3.6.1.4.1.232.154.2.10119)

42 Insight Management Agent: A CMC device is reporting lockset 1 is normal 
(1.3.6.1.4.1.232.154.2.10134)

43 Insight Management Agent: A CMC device is reporting lockset 2 is normal 
(1.3.6.1.4.1.232.154.2.10135)

44 Insight Management Agent: A UPS device is reporting output voltage is 
out of Range (1.3.6.1.4.1.232.154.2.21020)

45  Insight Management Agent: A UPS device is reporting an overload 
condition (1.3.6.1.4.1.232.154.2.20014)

46  Insight Management Agent: A UPS device is reporting an overload 
condition has cleared (1.3.6.1.4.1.232.154.2.20015)

47  Insight Management Agent: A UPS device is reporting low battery 
(1.3.6.1.4.1.232.154.2.21055)

48 Insight Management Agent: A UPS device is reporting low battery error 
has been cleared (1.3.6.1.4.1.232.154.2.21056)

49 Insight Management Agent: A UPS device is reporting on battery 
condition (1.3.6.1.4.1.232.154.2.21063)
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50 Insight Management Agent: A UPS device is reporting an On Buck 
condition (1.3.6.1.4.232.154.2.21029)

51 Insight Management Agent: A UPS device is reporting an On Boost 
condition (1.3.6.1.4.232.154.2.21031)

52 Insight Management Agent: A UPS device is reporting on Power Utility 
condition (1.3.6.1.4.1.232.154.2.21064)

53 Insight Management Agent: A UPS device is reporting temperature is out 
of range (1.3.6.1.4.1.232.154.2.20103)

54 Insight Management Agent: A UPS device is reporting a general UPS 
failure (1.3.6.1.4.1.232.154.2.20111)

55 Insight Management Agent: A UPS device is reporting a general UPS 
failure has been cleared (1.3.6.1.4.1.232.154.2.20112)

56 Insight Management Agent: A UPS device is reporting a battery failure 
(1.3.6.1.4.1.232.154.2.20121)

57 Insight Management Agent: A UPS device is reporting a battery failure 
has been cleared (1.3.6.1.4.1.232.154.2.20122)

58 Insight Management Agent: A UPS device is reporting a diagnostic test 
failed (1.3.6.1.4.1.232.154.2.20131)

59 Insight Management Agent: A UPS device is reporting a diagnostic test 
succeeded (1.3.6.1.4.1.232.154.2.20132)

60 Insight Management Agent: Input (Utility) for UPS: measured input 
frequency is outside of either the upper or lower frequency limit 
specification for normal operation (1.3.6.1.4.1.232.154.2.20141)

61 Insight Management Agent: UPS Measured input frequency is normal 
(1.3.6.1.4.1.232.154.2.20142)

62 Insight Management Agent: A UPS device is reporting bypass not 
available (1.3.6.1.4.1.232.154.2.20161)

63 Insight Management Agent: A UPS device is reporting bypass not 
available error has been cleared (1.3.6.1.4.1.232.154.2.20162)

64 Insight Management Agent: A UPS device is reporting the input wiring is 
NORMAL (1.3.6.1.4.1.232.154.2.20202)

65 Insight Management Agent: A UPS device is reporting a fault in the input 
wiring (1.3.6.1.4.1.232.154.2.20201)
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66 Insight Management Agent: A UPS device is operating in NORMAL mode 
(1.3.6.1.4.1.232.154.2.21060)

67 Insight Management Agent: A UPS device is operating in manual bypass 
mode (1.3.6.1.4.1.232.154.2.21059)

68 Insight Management Agent: A UPS device has been started while on 
utility power (1.3.6.1.4.1.232.154.2.20152)

69 Insight Management Agent: A UPS device has been started while on 
battery power (1.3.6.1.4.1.232.154.2.20151)

70 Insight Management Agent: A UPS device reporting input voltage out of 
range is NORMAL (1.3.6.1.4.1.232.154.2.21022)

71 Insight Management Agent: A UPS device is reporting input voltage is out 
of range (1.3.6.1.4.1.232.154.2.21021)

72 Insight Management Agent: A UPS device is reporting temperature is out 
of range (1.3.6.1.4.1.232.154.2.21007)

73 Insight Management Agent: A UPS device is reporting temperature is 
NORMAL (1.3.6.1.4.1.232.154.2.21008)

74 Insight Management Agent: A UPS device is operating in auto bypass 
mode 1.3.6.1.4.1.232.154.2.21047)

75 Insight Management Agent: A UPS device is not operating in auto bypass 
mode (1.3.6.1.4.1.232.154.2.21048)

76 Insight Management Agent: A UPS device is reporting output voltage is 
out of Range (1.3.6.1.4.1.232.154.2.21019)

77 Insight Management Agent: A UPS device is reporting batteries are not 
connected to the UPS (1.3.6.1.4.1.232.154.2.21053)

78 Insight Management Agent: A UPS device is reporting batteries are 
reconnected to the UPS (1.3.6.1.4.1.232.154.2.21054)

79 Insight Management Agent: A UPS device is reporting batteries are 
completely discharged (1.3.6.1.4.1.232.154.2.21057)

80 Insight Management Agent: A UPS device is reporting an output Breaker 
or Relay has failed (1.3.6.1.4.1.232.154.2.21041)

81 Insight Management Agent: A UPS device is reporting an output Breaker 
is functioning normally (1.3.6.1.4.1.232.154.2.21042)

82 Insight Management Agent: A UPS device is reporting an Emergency 
Power Off (EPO) command (1.3.6.1.4.1.232.154.2.21037)
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83 Insight Management Agent: The UPS has been powered off with user 
interaction (1.3.6.1.4.1.232.154.2.21033)

84 Insight Management Agent: The UPS output has been restored 
(1.3.6.1.4.1.232.154.2.21034)

85 Insight Management Agent: A UPS device is reporting a cover panel has 
been removed (1.3.6.1.4.1.232.154.2.21045)

86 Insight Management Agent: A UPS device is reporting a cover panel has 
been replaced (1.3.6.1.4.1.232.154.2.21046)

87 Insight Management Agent: A UPS device is reporting a fan failure has 
occurred (1.3.6.1.4.1.232.154.2.21035)

88 Insight Management Agent: A UPS device is reporting a fan failure has 
cleared (1.3.6.1.4.1.232.154.2.21036)

89 Insight Management Agent: A UPS device is reporting a loss of 
redundancy (1.3.6.1.4.1.232.154.2.21023)

90 Insight Management Agent: A UPS device is reporting a loss of 
redundancy cleared (1.3.6.1.4.1.232.154.2.21024)

91 Insight Management Agent: A UPS device is reporting a shutdown 
imminent condition (1.3.6.1.4.1.232.154.2.21013)

92  Insight Management Agent: A UPS device is reporting a shutdown 
imminent condition cleared (1.3.6.1.4.1.232.154.2.21014)

93 Insight Management Agent: A UPS device is reporting shutdown pending 
condition (1.3.6.1.4.1.232.154.2.21011)

94 Insight Management Agent: The UPS is no longer pending shutdown 
(1.3.6.1.4.1.232.154.2.21012)

95 Insight Management Agent: A critical alarm has occurred 
(1.3.6.1.4.1.232.154.3.1)

96 Insight Management Agent: A warning alarm has occurred for UPS 
(1.3.6.1.4.1.232.154.3.2)

97 Insight Management Agent: An alarm has cleared for UPS 
(1.3.6.1.4.1.232.154.3.4)
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HPSIMInt-IMAgents_FwdCIMTraps (CPQCIM.MIB)

1 Insight Management Agent: The GbE switch has successfully transferred 
a firmware image (1.3.6.1.4.1.232.0.161001)

2 Insight Management Agent: The GbE switch has successfully transferred 
a configuration file (1.3.6.1.4.1.232.0.161002)

3 Insight Management Agent: The GbE switch has successfully completed a 
TFTP transfer (1.3.6.1.4.1.232.0.161003)

4 Insight Management Agent: The GbE switch has failed a TFTP transfer 
(1.3.6.1.4.1.232.0.161004)

5 Insight Management Agent: Invalid firmware or configuration image 
downloaded (1.3.6.1.4.1.232.0.161005)

6 Insight Management Agent: The GbE switch fan has failed 
(1.3.6.1.4.1.232.0.161006)

7 Insight Management Agent: The switch fan has returned to normal 
operation (1.3.6.1.4.1.232.0.161007)

8 Insight Management Agent: The switch temperature sensor indicates a 
high temperature condition (1.3.6.1.4.1.232.0.161008)

9 Insight Management Agent: The switch temperature sensor indicates an 
over-temperature condition (1.3.6.1.4.1.232.0.161009)

10 Insight Management Agent: The switch temperature sensor indicates 
temperature has returned to normal (1.3.6.1.4.1.232.0.161010)

11 Insight Management Agent: The switch has successfully completed POST 
(1.3.6.1.4.1.232.0.161011)

12 Insight Management Agent: The switch has rejected a login attempt 
(1.3.6.1.4.1.232.0.161012)

13 Insight Management Agent: A SNTP Server was configured, but no SNTP 
servers were found (1.3.6.1.4.1.232.0.161015)
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